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EXECUTIVE SUMMARY 

This document accompanies the Deliverable 3.5 “Toolbox final version“ in order to describe the final version 

capabilities and provide documentation for all tools that make up the EUreka3D-XR Toolbox. The Toolbox 

consists of the components, while dedicated User Manuals are provided as an Annex 1 to this document: 

Tool name Main purpose Updated links to demonstration and documentation material 

AR Tour 
Builder 

Create AR tours where 
cultural heritage objects 
can be located on the 
map 
 
Pilot scenario: Bibracte 

Access to tool: 
a) Demo version: https://eureka.ails.ece.ntua.gr/  
b) Production version: 

artourbuilder.eureka3dxr.fedcloud.eu 
Documentation: 

a) User Manual 
b) API (documented in Swagger): 

https://eureka.ails.ece.ntua.gr/api/docs/  

AR Tour 
Experience 
 

Allow site visitors to 
access the AR tour 
 
Pilot scenario: Bibracte 

The mobile app can be downloaded from Google Play: Link 
 
Demo video v1 (Sep 2025) 
Demo video v2 (Jan 2026) 
A more up-to-date demo video is under preparation and will 
be published on Europeana for dissemination purposes. 

AI 3D Builder Reconstruct 3D models 
of lost heritage from 
archival materials 
 
Pilot scenario: Girona 

Access to tool (April 2026): https://www.swing-
it.net/eureka3dxr/ai3dbuilder/ 
 
Demo Video (April  2026): 
https://www.youtube.com/watch?v=5KF2Q62mn2I 
 
Demo Video (September 2025): 
https://www.youtube.com/watch?v=BqZFpM2HX0s  

3D XR Studio Position and share the 
3D models on an AR 
experience 
 
Pilot scenario: Girona 

Access to tool (April 2026):  
https://www.swing-it.net/eureka3dxr/3dxrstudio/ 
 
Demo Video (April  2026): 
https://www.youtube.com/watch?v=QJhAAihlyxI 
 
Demo video (September 2025): 
https://www.youtube.com/watch?v=ZALxLJtmbAI  

Avatar 
Builder 

Create animated and 
speaking 3D models of 
human characters 
 
Pilot scenario: Cyprus 

Video Tutorial (April 2026): 
https://www.youtube.com/watch?v=uEn4bzfusDA 
 
Also available for download: Link 

https://eureka.ails.ece.ntua.gr/
http://artourbuilder.eureka3dxr.fedcloud.eu/
https://eureka.ails.ece.ntua.gr/api/docs/
https://play.google.com/store/apps/details?id=com.ntua.ar_tour_experience&hl=en-US&ah=whSc8Sn3Y2wi1zCx2sQ2Th2AZF8
https://api.nakala.fr/embed/10.34847/nkl.2dd3j1kw/5ef8170965e6408e7e5e1792d76fc4c1e188bab8
https://api.nakala.fr/data/10.34847/nkl.8555d6qg/5059b2d448ec442bd1c89db16201651452c38462
https://www.swing-it.net/eureka3dxr/ai3dbuilder/
https://www.swing-it.net/eureka3dxr/ai3dbuilder/
https://www.youtube.com/watch?v=5KF2Q62mn2I
https://www.youtube.com/watch?v=BqZFpM2HX0s
https://www.swing-it.net/eureka3dxr/3dxrstudio/
https://www.youtube.com/watch?v=QJhAAihlyxI
https://www.youtube.com/watch?v=ZALxLJtmbAI
https://www.youtube.com/watch?v=uEn4bzfusDA
https://datahub.egi.eu/api/v3/onezone/shares/data/00000000007E58F1736861726547756964233764326231663739306163393534636463343034626430363933613531306165636864353031233665663637356366323134343661326366656235653866346139393233333165636865663265233661643662323130363739623564363335343037343064653830306433396634636866346466/content
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For each tool, an overview is provided by the responsible technical partner, enriched with screenshots or 

videos to offer a glimpse of how the tools appear to users and demonstrate how they function. The 

production versions of all tools are openly available online as a service - either on the EUreka Data Hub for 

web platforms or on GooglePlay for mobile apps. The  source code is also open and published on GitHub. 

Lastly, a step-by-step user guide is provided for each tool. It should be mentioned that the links to the 

documentation, services, and demonstration videos have been updated to reflect the latest developments 

conducted in the period since the release of D3.4 Toolset beta version1.  

The five tools have been tested in three pilot scenarios, set in different locations in Europe. The final version 

of the tools has incorporated, to the extent feasible, the feedback collected by project-internal and external 

stakeholders during the iterative evaluation.  

This deliverable is means of verification for Milestone 12 “Tools final release”. 

  

 
1 https://eureka3d.eu/wp-content/uploads/2025/11/EUreka3D-XR-D3.4-Toolbox-beta.pdf  

https://eureka3d.eu/wp-content/uploads/2025/11/EUreka3D-XR-D3.4-Toolbox-beta.pdf
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1. INTRODUCTION 

This deliverable presents the final of the five tools that comprise the EUreka3D-XR Toolbox, namely (as 

presented in D3.4): 

● AR Tour Builder: A web application for specifying AR tours by associating cultural heritage objects 

stored in online repositories, including 3D objects, with locations on a map (developed by NTUA) 

● AR Tour Experience: A mobile app that allows visitors to experience AR tours by visualising 3D digital 

objects within the physical environment and accessing several types of information associated with 

certain locations (developed by NTUA) 

● AI 3D Builder: A 3D Modelling software pipeline that uses AI and digital photo archives (developed 

by Swing:It) 

● 3D XR Studio: A web tool for creating AR experiences, using a range of predefined layouts for UX and 

UI (developed by Swing:It) 

● Avatar Builder: A framework that guides users in creating, animating, and preparing avatars for 

multiple visualisation platforms (developed by MIRALab) 

 

The final version of the tools is a revised version of D3.4 Toolbox Beta version, which incorporates all new 

functionalities and improvements developed from Nov 2025 to Apr 2026. The tools are aligned with the 

technical requirements defined in D3.1 Technical requirements2; the scenarios’ needs as specified in D2.1 

Pilot Specification and planning3; and quality strategies outlined in D3.6 Quality Assessment Report4 and D3.7 

Formats and quality guidelines report on M15 (April 2026). The tools have been evaluated in various ways 

and occasions, with more information about the latest evaluation results included in D2.5, D2.6 , and D2.7 

regarding the Pilot Prototypes v1.1 and D4.3 Impact assessment report, all due on M18 (July 2026). This 

deliverable also complements the D3.3 Cloud Infrastructure final release on M15, and is means of verification 

for Milestone 12 Tools final release. 

To facilitate readability and provide a comprehensive overview of the tools’ capabilities, this deliverable 

includes part of the content presented in D3.4 Toolset Beta Version (e.g. general tool descriptions and 

capabilities implemented during the beta phase). It expands this material to include all newly developed 

functionalities and the key activities carried out between November 2025 and April 2026. In addition, it 

provides links to updated resources—such as production services and demonstration videos—along with the 

developed step-by-step guidelines for each tool (provided as Annex) and further insights and an outline of 

the planned next steps.  

While each tool is tested in a specific pilot scenario within the project lifetime, all tools are designed in a 

generic way in order to allow reuse across various application scenarios. The tools’ functionalities have been 

co-designed through the collaboration between technical partners and partners from the cultural heritage 

sector, taking the needs of the pilot scenarios as the starting point. The tools have been developed iteratively 

based on the outcome of extensive testing, feedback collection and evaluation, including: 

 
2 https://eureka3d.eu/wp-content/uploads/2025/07/EUreka3D-XR-D3.1-Technical-Requirements.pdf  
3 https://eureka3d.eu/wp-content/uploads/2025/07/EUreka3D-XR-D2.1-Pilot-specification-and-planning.pdf  
4 https://eureka3d.eu/wp-content/uploads/2026/03/EUreka3D-XR-D3.6-Quality-assessment-report-v1.pdf  

https://eureka3d.eu/wp-content/uploads/2025/07/EUreka3D-XR-D3.1-Technical-Requirements.pdf
https://eureka3d.eu/wp-content/uploads/2025/07/EUreka3D-XR-D2.1-Pilot-specification-and-planning.pdf
https://eureka3d.eu/wp-content/uploads/2026/03/EUreka3D-XR-D3.6-Quality-assessment-report-v1.pdf
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• initial feedback from the EUreka3D-XR Advisory Board of experts5 provided during a dedicated 

meeting held on 8 July 2025, as well as further insights during a focus group on tool assessment 

organized on 31 October 2025. 

• feedback collected by attendees during presentations/demonstrations at events, including the 

Europeana Aggregators Forums in Spring and Autumn 2025, the “Reimagining cultural heritage in 3D 

and XR” capacity building event held in Brussels on 26/9/2025; and the demo event in Girona on 

29/1/2026. 

• feedback by the pilot partners (in Bibracte, Girona, and Cyprus) who extensively tested the tools and 

provided valuable insights, including recommendations for improvements, new functionalities and 

bug reports. 

• feedback from participants (including cultural heritage professionals, educators, tourist agents, etc) 

involved in evaluation sessions organised on-site by pilot partners in the period from late January to 

late April. 

The document is structured as follows. Sections 2-6 provide an overview of each tool, including essential 

information about its license, development status, etc., as well as links to further material that demonstrate 

the functionalities of each tool. Section 7 concludes with some lessons learnt and next steps. 

The diagram below depicts the overall schedule for the toolset releases and respective milestones. 

 

 

Fig. 1.1: Timeline for tools 

  

 
5 https://EUreka3d.eu/advisory-board/  

https://eureka3d.eu/advisory-board/
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2. AR TOUR BUILDER (NTUA) 
2.1 OVERVIEW 
 

AR Tour Builder 

Short Description The AR Tour Builder is a web application that supports the design of AR tours by 
associating 3D objects and other types of content (e.g. images, audio, text)  to 
specific  locations on a map. The builder is intended for CH professionals and other 
stakeholders who wish to prepare engaging experiences for  their on-site visitors. 
The platform offers asset management capabilities that allow users to add content 
selected from online platforms such as the EUreka3D Data Hub or CH organisations' 
own repositories.  
The user can specify multiple tours (e.g. short and longer tours, tours addressed to 
children, etc.) for the same geographical area, organised under Projects. Each tour 
consists of a set of georeferenced Points of Interests, each of which can encompass 
a set of various types of media assets as well as contextual information. The builder 
supports the creation of multilingual tours, where both the content and tour-
specific information can come in multiple languages.  
The  tours can then be accessed on-site via the companion AR Tour Experience 
mobile app, which presents the curated multimodal content based on the user’s 
geolocation. The focus is on outdoor experiences, enabling rich engagement with 
cultural sites through AR overlays, images, videos, audio, and textual content. 

Developed by: NTUA 

Supported 
functionalities 

Features implemented as part of the beta version include: 
- API functionalities supporting: user and user group management (sign in, sign 

up, etc.); asset management (creation, editing, deletion); project, tour and 
Points Of Interest management 

-  Setup of a Django web framework and a Postgres database 
- Partly functional User Interface: all pages designed but not integrated with the 

backend (ongoing implementation) 
Additional functionalities developed in the period Nov 2025 to Apr 2026 include: 

- Fully functional User Interface, integrated with the backend 
- Possibility for adding users as collaborators to a Project 
- Backend/API refinement (schema updates, fixes, etc.) 
- Integration with EGI Check-in  
- Support for PLY formats besides GLB 
- Support for ZIP files from the EUreka3D Data Hub that contain the 3D 

models and associated files 
- Support for adding georeferenced 3D models, by providing specific 

coordinates added as part of the POI asset metadata (see also AR Tour 
Experience app about how these are visualised)  

- Possibility to manually adjust the orientation of 3D models 
- Incorporation of visual elements (fonts, icons etc) provided by the designer 

appointed by the project 
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- Support for uploading images that are then presented as thumbnails for 
POIs on the AR Tour Experience app 

- Integrated testing with the AR Tour Explorer and iterative improvements 
Note: Initially, it was planned to support searching and selection of Europeana 
assets and extract the 3D objects from the returned items. However, this was not 
feasible, since the link to the 3D file is not included in the current Europeana Data 
Model metadata record returned by the Europeana platform. Therefore, we leave 
this feature as a possible future improvement that may become possible when the 
extended version of the EDM, which encourages the incorporation of the download 
URL of a 3D model, is put in place.  Instead of this feature, we decided to focus on 
implementing some alternative additional features, including the possibility to 
adjust the 3D models’ orientation and the support for ZIP files. 

Available on: Latest version of source code on Github:  
https://github.com/EUreka3D-XR/AR-Tour-Builder 
 
API (documented in Swagger): https://EUreka.ails.ece.ntua.gr/api/docs/  
 
Demo web tool version available on: https://EUreka.ails.ece.ntua.gr/  
 
Production version available on: artourbuilder.EUreka3dxr.fedcloud.eu 

Licence: Apache 2.0 

Accompanying 
material: 

Step-by-step user instructions  
 
Fact sheet 

 

2.2 BACKEND CAPABILITIES 
The backend has been built using the Django web framework6. All capabilities offered by the AR Tour Builder 

are exposed via a well-defined API, accessible to any authorised third-party application. The following sets of 

functionalities have been implemented and are fully functional: 

- User management: User authentication, account management, and user-related operations, 

including login, signup, and user listing. 

- User groups: Manage user groups and group membership for collaborative projects. 

- Project: Create and manage tours with group-based permissions and metadata. 

- Assets: Manage media assets (images, videos, audio) with automatic thumbnail generation and 

metadata. Supports creation of projects or POIs with source asset selection. 

 
6 https://www.djangoproject.com/  

https://github.com/EUreka3D-XR/AR-Tour-Builder
https://eureka.ails.ece.ntua.gr/api/docs/
https://eureka.ails.ece.ntua.gr/
http://artourbuilder.eureka3dxr.fedcloud.eu/
https://www.djangoproject.com/


 

 

 

 
 

 

 Grant Agreement n. 101174054  9 

- Tours: Build and manage interactive tours with customizable routes, content, and multilingual 

support. 

- Points Of Interest: Manage Points of Interest (POIs) with rich metadata, coordinates, and 

multilingual content. 

In the period of Nov 2025 to Apr 2025, the backend has undergone minor improvements and bug fixes. The 

main extension concerns the integration with the EGI Check-in authentication and authorization system. 

2.2.1 Database schema 

The database is set up using Postgres, which implements all structures representing the various elements 

(users, user groups, projects, tours, assets, maps, POIs and their sub-elements) The Entity Relational diagram 

of the database schema can be seen in the following Figures 2.1 and 2.2. No significant changes have occurred 

since Oct 2025. 

 

 

Figure 2.1: ER Diagram presenting the main elements of the AR Tour Builder database: Project, Tour, POI and Asset. 
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Figure 2.2: ER Diagram underpinning the elements of the user management system. 

 

2.3 UI CAPABILITIES 
The implementation of the User Interface of the AR Tour Builder has been the main focus since the beta 

version release. All envisioned functionalities as described in Section 2.1 are served to the end user via user-

friendly web pages that support the entire workflow, from the library page and project/tour creation to 

assets population and POI editing. All pages are fully functional and integrated with the backend via API calls.  

Below we provide some indicative screenshots of the AR Tour Builder’s pages. A detailed overview of the 

complete workflow steps supported by the tool, along with the respective web pages, is available as Annex 

to this document. 
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Figure 2.3:Screenshot of a Project Dashboard Overview page 

 

 
Figure 2.4. Screenshot from the Poi Editor Sidebar - Poi’s location information 
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2.4 EVALUATION AT BIBRACTE 
All functionalities of the AR Tour Builder have been extensively tested by the Bibracte team, leading to several 

bug fixes and improvements. The almost-final version of the AR Tour Builder (as in Mar 2025) was evaluated 

by a group of 18 stakeholders, including cultural heritage professionals, educators, tourist operators, and 

researchers,  during  dedicated evaluation sessions organised from Mar 30- Apr 4 2026.  

The stakeholders responded positively to the overall workflow supported by the AR Tour Builder, noting that 

it is intuitive and easy to follow. They were able to successfully add Points of Interest (PoIs) on the map and 

particularly appreciated the support for multiple media types, multilingual assets, 3D model management, 

and the PoI radius configuration feature. Overall, they highlighted the tool’s strong potential for professional 

use within their domain.  

The main limitation identified relates to the reliance on external links for media assets. Stakeholders noted 

that finding suitable URLs -especially for 3D content- can be challenging, which in practice restricts the ability 

to enrich PoIs with 3D models. While the AR Tour Builder is not designed to host media content directly (and 

therefore this dependency on external URLs cannot be fully avoided), several enhancements—implemented 

following the evaluation—aim to mitigate these challenges, including: (a) support for additional 3D media 

formats (namely GLB and PLY), and (b) the ability to link to 3D models hosted on the EUreka3D Hub, through 

support for managing and visualising ZIP files, which constitute the standard file format on the hub. 

Moreover, participants stressed out the need for documentation and support, a need that has been 

addressed through the step-by-step guide provided in Annex. More detailed information about the 

evaluation and its findings will be provided in D2.6. 
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3. AR TOUR EXPERIENCE (NTUA) 

3.1 OVERVIEW 
 

AR Tour Experience 

Short Description The AR Tour Experience is a mobile app  that complements the AR Tour Builder 

tool and serves the tours designed via the AR Tour Builder to on-site visitors. 

Through a clean and intuitive interface, visitors can browse and select tours 

available in their location based on their preferences. The app uses GPS to provide 

real-time navigation, detecting when users approach certain points of interest and 

prompting them to visualise the various types of content (3D models, images, 

video, audio and text) associated with them. The 3D models can be displayed 

either in a dedicated 3D viewer or overlaid on the physical environment, as 

captured by the mobile camera. These AR views can be used to enhance on-site 

points of interest with elements that are no longer visible or present on the 

location, such as backfilled excavations, virtual reconstructions, or artefacts 

currently exhibited in a museum. The app also supports tour progression tracking 

and offers practical features such as pre-downloadable content for low-

connectivity environments. The application is implemented for Android devices. 

Developed by: NTUA 

Main functionalities Features implemented as part of v1 (beta version) include: 
- Navigation pages for browsing projects and tours 
- Tour navigation on a map 
- Prompting based on GPS tracking 
- PoI page with various multimedia content 
- Dedicated visualisation pages for different types of assets (images, 

documents, links et) 
- 3D viewer for exploring 3D objects along with supporting audio  
- AR view for visualising 3D objects either anchored on a specific position 

based on georeferencing information or freely positioned 
- Multilingual support 

Functionalities implemented in the period Nov 2025 to Apr 2026 include: 
- Exact anchoring of georeferenced 3D  models in the AR experience mode: 

the user is provided with hints to rotate their camera so that  the models 
are visualised at the exact intended location and with accurate 
orientation. 

- Improvements in file management (smart caching) 
- Incorporation of visual elements (fonts, icons etc) provided by the 

designer appointed by the project 
- Support for the visualisation of OBJ 3D model formats (besides GLB)  
- Support for orienting 3D models relative to actual cardinal directions 
- Support for unzipping and visualisation of 3D models in ZIP files hosted on 
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the EUreka3D Data Hub 

Available on Latest version of source code on Github:  
https://github.com/EUreka3D-XR/AR-Tour-Experience 
https://github.com/EUreka3D-XR/AR-Tour-Builder-backend 
 
The mobile app can be downloaded from Google Play: Link 

Licence Apache 2.0 

Accompanying 
material 

Demo video v1 (Sep 2025) 
Demo video v2 (Jan 2026) 
A more up-to-date demo video is under preparation and will be published on 
Europeana for dissemination purposes. 
 
Step-by-step user instructions  
 
Fact sheet 

 

 

3.2 BASIC CAPABILITIES AND TESTING OUTCOMES 
All important functionalities of the AR Tour Experience mobile app as prescribed in D3.1 Technical 

Requirements document have been implemented and tested. Below, we provide some indicative screenshots 

and photographs of the Bibracte tour, taken at the evaluation of the mobile app at the archaeological site. 

More shots from the Bibracte tour can also be found in the demo video (see link above). A detailed overview 

of the basic workflow steps the app supports and the respective screens presented to the user is available 

and published on the project's website, as linked in the table above. 

https://github.com/EUreka3D-XR/AR-Tour-Experience
https://github.com/EUreka3D-XR/AR-Tour-Builder-backend
https://play.google.com/store/apps/details?id=com.ntua.ar_tour_experience&hl=en-US&ah=whSc8Sn3Y2wi1zCx2sQ2Th2AZF8
https://api.nakala.fr/embed/10.34847/nkl.2dd3j1kw/5ef8170965e6408e7e5e1792d76fc4c1e188bab8
https://api.nakala.fr/data/10.34847/nkl.8555d6qg/5059b2d448ec442bd1c89db16201651452c38462
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Figure 3.1: Starting a tour: a) map view with POIs b) photograph from testing session at the Bibracte archaeological 

site. 

 

 
 

Figure 3.2: Example of 3D models as they appear in Bibracte: a) 3D model with associated audio presented in 3D 

viewer. The possibility to switch to AR mode appears on the top left; b) 3D model in AR view. 
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3.3 TESTING AT THE BIBRACTE ARCHAEOLOGICAL SITE 
A first prototype of the mobile app was tested during a dedicated visit at the Bibracte archaeological site in 

September 17–18, 2025 as described in the previous version of this deliverable. The recommendations 

resulting from this initial testing (including support for more 3D formats, georeferenced models, and dealing 

with underground structures) have been implemented as part of the final version.  

The Tour Experience app was also evaluated at the Bibracte site in Apr 2026 by the same group of 

stakeholders who assessed the AR Tour Builder (see Section 2.4). However, the session was adversely 

affected by poor weather conditions, which resulted in limited connectivity on the day. As a result, the 

evaluation was confined to a small number of Points of Interest (PoIs) located within a restricted area around 

the archaeological centre. Despite these constraints, participants confirmed the app’s strong relevance for a 

wide range of audiences, including independent visitors, tour groups, students, and school pupils. They 

particularly valued the easy access to rich multimedia content and expressed strong interest in the 3D 

models, both through the 3D viewer and in AR mode. 

Some challenges were also identified. Several participants encountered difficulties with downloading the app 

due to compatibility issues with their mobile devices. In addition, there was some lack of clarity regarding 

the precise positioning of 3D models at certain locations. 

To address the deployment difficulties and compatibility issues, a number of improvements have been 

implemented: (a) the app is now available via Google Play, replacing the previously more complex installation 

process; and (b) it can now be deployed on devices that do not support AR functionality, allowing users to 

benefit from all other features of the Tour Experience. Furthermore, a step-by-step user guide has been 

developed and is included in Annex to support users in navigating and making the most of the application. 
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4. AI 3D BUILDER (SWING:IT) 

4.1 OVERVIEW 

AI 3D Builder 

Short Description The AI 3D Builder is designed to transform two-dimensional images into complete, 

usable three-dimensional models. Its main goal is to drastically reduce the time 

required to create 3D assets by automating a process that traditionally demands 

expertise in modelling, texturing, and rendering. At the heart of this pipeline lies Trellis, 

a system based on an AI architecture that employs Structured Latents (SLAT) 

representation, enabling the system to capture visual characteristics and implicit 

spatial relationships to reconstruct three-dimensional shapes coherently and 

realistically. While artificial intelligence handles automatic reconstruction, human 

intervention ensures final quality. This is particularly useful when the images are few, 

lack detail, or contain distracting elements. Human intervention is also needed for the 

creation or enhancement of textures, by using photo editing softwares, which are 

applied to the final model. Since the tool was the first real prototype to be used for the 

development of the Girona scenario, it was also the first tool to be completed on time 

compared to the scheduled deadline. The tool has also been advertised during the “AI 

for 3D Digital Twins in Cultural Heritage” event, which took place online on March 23rd.  

Developed by: Swing:IT 

Main 

achievements so 

far 

Features implemented as part of v1 (beta version) include: 

● Image upload via web interface 

● Configuration of generation and optimisation parameters 

● Execution of Trellis AI engine 

● Export of generated models in GLB format, compatible with most 3D viewers 

and rendering engines 

● Refinement through manual post-processing steps involving mesh 

simplification and texture cleanup 

● Dedicated GPU backend with a communication API system 

● Functional user interface and temporary storage for data during processing 

● Integration with DataHub for storage and content distribution 

Additional functionalities developed in the period Nov 2025 to Apr 2026: 

● Tool brought to production stage 

● Optimization of the pipeline based on the feedbacks received during the 

Workshop in Girona 

● User authentication via JWT, supporting both local credentials and EGI 

OAuth. 
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● Image upload (PNG, JPEG, WEBP, up to 10MB) via drag & drop, clipboard, or 

file selection. 

● Configuration of advanced parameters (seed, guidance strength, sampling 

steps, mesh simplification, texture size, output format). 

● Support for single-image and multi-image modes to improve geometric 

reconstruction. 

● Single-tenant FIFO queue system with real-time monitoring, optional 

preview, and process control. 

● 3D model visualization and download, generation history; React frontend 

(IT/EN) and backend with automatic retry and recovery. 

Available on Source code on Git Repository: 

https://github.com/EUreka3D-XR/AI-3D-Builder 

Web Service: https://www.swing-it.net/EUreka3dxr/ai3dbuilder/ 

URL provided by the project (ai3dbuilder.EUreka3dxr.fedcloud.eu ) redirects to 

Swing:It server/domain 

Accompanying 

material 

Video showcasing the AI 3D Builder workflow: 

https://www.youtube.com/watch?v=BqZFpM2HX0s 

 

User Manual 

Factsheet 

  

4.2 BASIC CAPABILITIES AND WORKFLOWS 

Technologies and Framework: The AI pipeline is built around Trellis, using Structured Latents (SLAT) 

representation. Trellis runs on GPUs with at least 16 GB of VRAM for optimal performance. The backend 

architecture includes: REST API layer, job orchestration module, temporary storage for intermediate files, 

and data encryption system. 

User Interface: Web-based interface allowing users to upload images and configure generation parameters 

including Quality/Detail, Guidance Strength, and Simplification Parameters. Communication with the 

backend via REST API calls. 

https://github.com/EUreka3D-XR/AI-3D-Builder
https://www.swing-it.net/eureka3dxr/ai3dbuilder/
http://ai3dbuilder.eureka3dxr.fedcloud.eu/
https://www.youtube.com/watch?v=BqZFpM2HX0s
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Fig. 4.1: User interface 

Output: Primary output is GLB file (glTF family format), designed for web and augmented reality. Also 

supports Radiance Fields and Gaussian Representations for research contexts. 

Integrations: Compatible with DataHub and EUreka3D platforms. Generated models can be transferred to 

3D XR Studio for building immersive experiences. 

Human Intervention: Required for refining the models output from Trellis. The first step involves modifying 

the images input to Trellis to isolate the subject. After the AI has processed the object, image manipulation 

software (such as Adobe Photoshop or similar) is used to create the texture to be associated with the object, 

and modeling software (such as Blender) is used to refine and optimize the mesh, as well as to associate the 

texture and export the final 3D model. 
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4.3 EVALUATION AT THE DEMO EVENT IN GIRONA 

The tool was used to create models of the tower, a portion of the wall, and the bastion of Saint Francis in the 

walls of Girona. It was subsequently used in the workshop held on January 29, 2026. The workshop was aimed 

at archivists and curators who wished to apply the tool to create 3D models from images of CH objects of 

their own collections that are not existing anymore. Before the workshop, materials (images, files, and a 

guide) were distributed to guide participants step-by-step. The guide also includes video tutorials to provide 

additional support to participants and, in general, anyone who wants to experiment with the tool. Overall, 

participants were interested in the entire process, although they encountered some difficulties, mainly due 

to their lack of experience with image manipulation and 3D modelling software. From a technical point of 

view, all participants managed to easily access all the software needed to carry out the exercise, with minor 

time losses. Despite this, participants were able to reproduce the results of the test material provided for the 

workshop, expressing their enthusiasm and curiosity (as well as some doubts due to the use of AI) towards 

this new approach. All the outcomes from the Girona Workshop are reported in the Impact Assessment 

report. 
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5. 3D XR STUDIO (SWING:IT) 

5.1 OVERVIEW 

3D XR Studio 

Short Description The 3D XR Studio is a web-based authoring tool that allows users to create 

immersive experiences in Extended Reality (XR) and Augmented Reality (AR). 

 It enables users to combine different types of multimedia content (3D models, 

images, videos, audio, and text) into interactive scenes, creating narrative paths and 

virtual environments that can be explored via mobile devices or AR/XR headsets. 

Specifically designed for cultural heritage professionals with an intuitive, no-code 

interface. 

Developed by: Swing:IT 

Main achievements 

so far 

Features implemented as part of v1 (beta version) include: 

● Web editor for area selection, 3D model upload, and scene positioning 

(rotation, scaling) 

● Creation of guided tours with multiple stages 

● POIs (Points of Interest) enriched with audio, video, images, and text 

● RESTful APIs (NodeJS and MariaDB) managing projects, geographic areas, 

models, and media 

● Mobile module with Placement Without Anchors functionality 

● Occlusion planes for realistic virtual-real environment interactions 

● Administrative tools for object transformation and manipulation 

● Mini-map for orientation and guided tour visualisation 

● Interactive POIs with multimedia content 

● Multilingual content support 

Additional functionalities developed in the period Nov 2025 to Apr 2026: 

● SSO Integration (EGI Check-in) for authentication and access management 

● User Experience (UX) Improvement in web editor 

● User Interface (UI) Improvement in mobile component 

● Improvements about light management for the mobile component based 

on feedback gathered during the experience in Girona 

● Performance and stability optimisations for APIs 
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Available on Source code on Git Repository: 

https://github.com/EUreka3D-XR/3D-XR-Studio 

Web Service: https://www.swing-it.net/EUreka3dxr/3dxrstudio/ 

URL provided by the project (3dstudioxr.EUreka3dxr.fedcloud.eu) redirects to 

Swing:It server/domain 

Accompanying 

material 

 Video showcasing 3D XR Studio operation: 

 https://www.youtube.com/watch?v=QJhAAihlyxI 

 

User Manual 

Factsheet 

 

5.2 BASIC CAPABILITIES AND WORKFLOWS 

Technologies: Hybrid architecture with a Web component for editing/design and a Mobile component for in-

situ visualisation. Backend based on RESTful API (NodeJS and MariaDB). Innovative Placement Without 

Anchors approach using coordinates and virtual geometric references. 

Application Type: Hybrid web and mobile system providing a cohesive workflow: design on web, validate on-

site, refine online, and distribute for public access. 

Integrations: Fully integrated into EUreka3D-XR project workflow. Curators access via EGI Check-in. 

Compatible with EUreka3D Data Hub for asset management. Part of an interoperable chain supporting the 

complete life cycle of digital cultural assets. 

5.3 EVALUATION AT THE DEMO EVENT IN GIRONA 

At the event held in Girona in the last week of January, for the first time the models of the walls, tower and 

bastions of Girona have been tested in the real scenario.  

The archivists at CRDI gave valuable feedback about suggestions in order to improve the user interface as 

well as providing a better light management affecting the mobile component of the 3D XR Studio. The 

evaluation stage took into account also the creation from scratch of a tour by creating path points and points 

of interests, checking the correct vertical alignment of the dots created during the process, that was adjusted 

in the latest deployment builds. 

  

https://github.com/EUreka3D-XR/3D-XR-Studio
https://www.swing-it.net/eureka3dxr/3dxrstudio/
http://3dstudioxr.eureka3dxr.fedcloud.eu/
https://www.youtube.com/watch?v=QJhAAihlyxI
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6. AVATAR BUILDER (MIRALAB) 

6.1 OVERVIEW 

Avatar Builder 

Short Description The use of virtual humans in cultural heritage offers significant advantages for 
interpretation, education, and audience engagement. By embodying historical or 
fictional personas, virtual humans can serve as interactive mediators bridging the 
gap between visitors and cultural content. They provide a humanised interface 
through which complex historical, archaeological, or artistic information can be 
conveyed in an engaging way. In museum settings, such avatars can act as virtual 
guides or storytellers, presenting narratives, answering predefined questions, and 
adapting communication to different audiences. Beyond museums, virtual humans 
have potential applications in education, tourism, and heritage preservation, 
supporting remote accessibility and inclusive experiences.   
To effectively support the creation and deployment of virtual humans in cultural 
heritage contexts, a structured and accessible production process is essential. 
Developing expressive and platform-compatible avatars typically requires technical 
expertise in 3D modelling, animation, and software integration, skills that are often 
beyond the reach of curators or heritage professionals. To address this challenge, 
we have designed the Avatar Builder (Figure 6.1): a process framework that guides 
users in creating, animating, and preparing avatars for multiple visualisation 
platforms. By leveraging open-source, accessible software, it makes avatar 
production possible for non-experts while ensuring compatibility with immersive 
VR/MR environments and web-based 3D viewers.  

 
Figure 6. 1 - Visual process guide  
 
Complementing this framework, we have also developed the EUreka3D-XR Web 
Viewer. This web-based application enables the visualisation and sharing of 3D 
content, ranging from static objects to fully animated avatars with synchronised 
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audio. The viewer provides a lightweight and accessible way to explore these 
creations directly through the Eureka3D-XR Data Hub: once a 3D file or animation 
is uploaded, users can visualise it online simply by providing its file ID. This seamless 
integration facilitates easy deployment, collaborative review, and public 
dissemination, allowing researchers, museum professionals, and other 
stakeholders to interact with cultural heritage assets and their digital 
representations within an intuitive browser-based environment.  

 
Figure 6.2 - Web Viewer with different controllers for animation.  
 

Developed by: MIRALab 

Main achievements 
so far 

● Defined an open pipeline for avatar creation with free and easy tools.  

● Enabled avatars to be cross-platform compatible (Unity + 
WebGL/Babylon.js).  

● Developed the first version of the EUreka3D-XR Web Viewer.   
To date, we have conducted a series of evaluations and comparative tests among 
existing open-source tools to identify the most effective workflow for creating and 
deploying 3D avatars. The primary objective was to establish a fully open-source, 
user-friendly, and accessible pipeline. Through these tests, we developed and 
validated a process that guides users from avatar creation and animation to export 
and integration within visualisation platforms such as Unity (for Quest 3 immersive 
applications) and Babylon.js (for web-based visualisation). This workflow ensures 
that individuals without advanced technical expertise can efficiently produce, 
animate, and deploy interactive avatars across multiple platforms using freely 
available tools.  
In parallel, we have developed the EUreka3D-XR Web Viewer, a lightweight 
browser-based application for visualising a wide range of 3D assets, from static 
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cultural heritage objects to fully animated avatars with synchronised audio. The 
development of this version of the viewer includes several key functionalities:  

● Animation controls for play, pause, and reset;  

● Speed adjustment to slow down or accelerate the animation;  

● Timeline slider to navigate to specific moments in the animation;  

● Audio synchronisation ensuring alignment between motion and sound;  

● Background customisation with different colour options;  

● Lighting and environment controls to adapt the scene’s ambience.  
 
Additional functionalities developed in the period Nov 2025 to Apr 2026: 

1/ Facial Animation – Simplified and Robust Approach 
During the reporting period (November 2025 – April 2026), additional 
investigations were carried out to identify a facial animation solution that aligns 
with the project’s core principles: accessibility, ease of use, and reliance on open-
source tools. 
However, due to the rapid evolution of Blender and the limited compatibility of 
several existing add-ons with recent versions, implementing advanced facial 
animation features, such as automated lip synchronization, remains challenging. 
Many available solutions are not yet fully stable within current Blender 
environments, often resulting in technical errors, complex configuration 
procedures, or inconsistent outputs. 
To address these limitations, a simplified and reliable approach to facial animation 
has been developed and integrated into the Avatar Builder workflow. This 
approach prioritizes robustness and usability, ensuring that non-technical users 
can easily follow the process without requiring advanced expertise. 
The proposed method maintains full compatibility with recent Blender versions 
while still enabling users to experiment with essential facial animation techniques.  
 
A dedicated user guide has been produced to document this workflow in a clear, 
step-by-step manner and a link to the updated user guide, including the facial 
animation section, is provided below. 

2/ Extension of the EUreka3D-XR Web Viewer 

During the reporting period, the EUreka3D-XR Web Viewer was further extended 
with enhanced navigation, content management, and visualisation capabilities. 
These improvements focus on increasing usability, flexibility, and compatibility 
with diverse types of 3D content. 

The following features have been implemented: 

● Scene switching: Users can seamlessly navigate between multiple 3D 
scenes (GLB files), each containing distinct animations, via an intuitive 
dropdown menu. This enables the integration of multiple narrative or 
visual states within a single experience. 

● Narration-only mode: The viewer now supports audio playback 
independently of animation. This allows narration or descriptive content 
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to be delivered even when 3D objects remain static, broadening 
accessibility and use cases. 

● Extended format compatibility: Support has been expanded to include 
additional 3D file formats, such as .ply, increasing interoperability with a 
wider range of 3D data sources. 

● Multi-file package support: The system can now handle multiple 
animation files bundled within a single .zip package stored in the Data 
Hub. This facilitates more efficient content organisation and deployment. 

● Improved data management and visualisation: Integration with the 
EUreka3D Data Hub has been enhanced to ensure smoother interaction, 
improved asset organisation, and better handling of associated metadata. 

● oEmbed integration with Europeana: The viewer now supports oEmbed 
functionality to enable seamless embedding of Europeana-hosted CH 
assets directly within their environment. This integration allows their 
content (e.g., 3D models, images, multimedia records) to be dynamically 
retrieved and displayed. This enhances interoperability with European 
cultural data infrastructures. 

All these functionalities are now thoroughly documented, with detailed guidance 
and examples available in the EUreka3D XR Github. This ensures that users can 
easily access, understand, and reuse the developed features within their own 
workflows. 

These developments contribute to a more robust and user-friendly web-based 
visualisation environment, supporting a wider range of content scenarios and user 
needs. 

Licence ● The process itself → Open / Creative Commons methodology  
● Avatars and assets → depend on the open-source tools and models used  
● Web Viewer Source Code: Released under the MIT License and publicly 

available for reuse and adaptation. It can be accessed here.  

Available on MIRALab 3D Animation Viewer: https://github.com/EUreka3D-

XR/WebAnimationViewer 

Avatar Builder video user Guide 

Video Tutorial (April 2026): 
https://www.youtube.com/watch?v=uEn4bzfusDA 
Also available from Download: Link 

Accompanying 
material 

● Complete user guide document about creation/customisation and 
animation of Virtual Humans 

● Sample avatars (with animations + metadata)  
● Best practices for exporting avatars on different visualisation platforms 

(Unity, Babylon.js). 

 

https://github.com/EUreka3D-XR/WebAnimationViewer
https://github.com/EUreka3D-XR/WebAnimationViewer
https://github.com/EUreka3D-XR/WebAnimationViewer
https://www.youtube.com/watch?v=uEn4bzfusDA
https://datahub.egi.eu/api/v3/onezone/shares/data/00000000007E58F1736861726547756964233764326231663739306163393534636463343034626430363933613531306165636864353031233665663637356366323134343661326366656235653866346139393233333165636865663265233661643662323130363739623564363335343037343064653830306433396634636866346466/content
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6.2 BASIC CAPABILITIES AND TESTING OUTCOMES 

Basic capabilities  

● Avatar Creation  

○ Use open-source tools (Blender, MakeHuman).  

○ Customise appearance, clothing, and features.  

● Animation & Voice  

○ Add body movements, gestures (MIxamo)   

○ Creating facial animation (Blender) 

○ Integrate voice (recorded audio or AI generated text to speech).  

● Export for Visualisation Platforms  

○ Export to GLTF/GLB (for Babylon.js Web Viewer).  

○ Export to FBX/Unity package (for Quest 3/Unity).  

 

Testing outcomes 

Updated Avatar of Saint Neophytos – Integration of Refined Historical Data 

Following the initial testing outcomes presented in the previous reporting period, a new and significantly 

enhanced version of the avatar of Saint Neophytos has been developed. 

While the first version successfully demonstrated the feasibility of integrating avatars into immersive VR and 

web-based environments for cultural heritage storytelling, it was based on preliminary historical references. 

In the current reporting period, newly provided and validated historical data have been incorporated, 

substantially improving the accuracy and credibility of the simulation. 

These updated inputs include detailed information on the saint’s physical appearance, clothing, hairstyle, 

posture, and overall presence. Each of these aspects has been carefully translated into the 3D modelling and 

animation process to achieve a more historically faithful representation. 

In parallel, historically grounded narrative texts were produced and recorded by a professional voice actor. 

This has resulted in high-quality audio narration that aligns with the latest historical research, reinforcing 

both the authenticity and the narrative depth of the experience. All these refinements have been fully 

implemented in the latest version of the avatar, leading to a more coherent, credible, and immersive user 

experience compared to the initial prototype. 

The updated avatar will be demonstrated across three complementary visualisation setups during the final 

project meeting in Paphos. This final iteration illustrates the evolution of the workflow from a proof of 

concept to a historically grounded and production-ready solution for cultural heritage applications. 

Web Version (tests performed):  

● 3D asset formats: Verified loading and visualisation of GLB (with and without animation) and 

OBJ (with texture files) models. Examples in Figures 6.3, 6.4, 6.5, and 6.6.  

https://www.blender.org/download/
https://static.makehumancommunity.org/makehuman/releases.html
https://www.mixamo.com/
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● Content types: Confirmed correct handling of static objects and animated scenes (single-file 

GLB with embedded animations).  

● Audio assets: Tested MP3 narration files linked to animated avatars; validated user-triggered 

playback to comply with browser autoplay policies.  

● Data access & integration: Deployed a local Node.js server to proxy requests and integrate 

with the EUreka Data Hub. Using file IDs, the viewer successfully fetched and rendered GLB/OBJ 

models and retrieved MP3 audio from the Data Hub.  

● Packaging scenarios: Tested both single-file uploads (e.g., single GLB) and ZIP packages 

containing multiple files stored in the Data Hub; confirmed retrieval via the Node proxy.  

● Scene switching: Validated navigation across multiple 3D scenes within a single session using 

the dropdown interface. Confirmed correct loading of distinct animations and state transitions. 

● Narration-only mode: Verified audio playback (MP3) independently of 3D animation. 

Confirmed correct triggering of narration for static scenes and compliance with browser 

autoplay restrictions. 

● Extended format compatibility: Tested successful loading and visualisation of additional 3D 

formats, including .ply, alongside existing GLB and OBJ support. 

● Multi-file package support: Evaluated ZIP-based deployments containing multiple animation 

files; confirmed correct extraction, indexing, and selective loading of assets from packaged 

content stored in the Data Hub. 

 

 
         Figure 6.3 - Static object (.glb) extracted from .zip file.  Figure 6.4 - Static object (.obj) with texture files.  
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Figure 6.5 - Static object (.glb) obtained from the 

data hub directly in the original format.  

  
Figure 6.6 - Animation in the viewer with 

synchronised audio and playback controls.  
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7. CONCLUSIONS, NEXT STEPS, AND DIRECTIONS FOR FUTURE WORK 

This document accompanies the D3.5 Toolbox final version (DEM), providing a comprehensive overview of 

the five tools developed within the project, along with access to their respective services and supporting 

resources. The final versions of all tools have now been successfully released, marking a significant milestone. 

In addition, detailed demonstration videos and user manuals have been produced to guide users through the 

core functionalities and showcase the full range of capabilities offered by each tool, ensuring accessibility for 

both technical and non-technical audiences. The evaluation process, which drew on feedback from diverse 

stakeholders through multiple channels (see D4.3 Impact Assessment Report for further details), yielded 

particularly positive outcomes. Respondents consistently highlighted the strong relevance of the Toolbox to 

current sector needs, especially the growing demand for open and interoperable XR solutions. Importantly, 

the evaluation confirmed the high level of usability and maturity of the developed solutions. The tools were 

widely perceived as innovative and well-aligned with real-world use cases, demonstrating clear potential to 

support content creation and visitor engagement workflows. 

Overall, the feedback reaffirms not only the high level of interest in open XR tools within the sector, but also 

the tangible usefulness and impact potential of the EUreka3D-XR Toolbox. The final versions of the tools will 

be showcased to a wider audience during a public event to be held in Cyprus on 26 May 2026, providing an 

opportunity to further demonstrate their capabilities and engage with prospective users and stakeholders. 

Further minor improvements to the tools are also foreseen to take place until the end of the project, in light 

of the feedback to be received by end users during the remaining period. 

Several directions for future extensions and improvements of the toolset have been identified through 

feedback from end users, evaluation participants, and consortium partners. These include, for example, a 

tighter integration with Europeana, enabling the search and selection of 3D models directly within the 

Europeana environment (potentially facilitated by the inclusion of model links in the EDM) as well as support 

for additional file formats and enhanced functionalities. Integration of sharing features for visited augmented 

reality tourist attractions via social media or gamification in tools can also improve user engagement. 

Moreover, the integration of social media could also spread outcomes of the project in a wider manner. 

While these ideas reflect clear user needs and promising avenues for further development, they fall beyond 

the scope and resources of the current project and are therefore considered as opportunities for future work. 
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ANNEX 1: USER MANUALS 
 

- AR Tour Builder 

- AR Tour Experience 

- AI 3D Builder 

- 3D XR Studio 

- Avatar Builder 
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INTRODUCTION 
The AR Tour Builder is a web application that supports the design of AR tours by associating 3D objects and 

other types of content (e.g., images, audio, text) to specific locations on a map. The builder is intended for 

CH professionals and other stakeholders who wish to prepare engaging experiences for their on-site visitors. 

The platform offers asset management capabilities, allowing users to pin content hosted on online 

platforms such as Europeana, the EUreka3D Data Hub or the CHI’s own repository. The user can specify 

multiple tours for the same geographical area, organised as individual projects (e.g., short or longer tours, 

tours addressed to children, etc.). Each tour consists of a set of georeferenced points of interest, each of 

which can be associated with a set of various media assets and contextual information. The builder supports 

the creation of multilingual tours, where both the content and tour-specific information can be provided in 

multiple languages. Tours can be accessed on-site via the companion AR Tour Experience mobile app, which 

presents the curated multimodal content based on the user’s geolocation. The focus is on outdoor 

experiences, enabling rich engagement with cultural sites through AR overlays, images, videos, audio, and 

textual content. 

 

BY FOLLOWING THIS GUIDE, YOU WILL BE ABLE TO 
●​ Create and manage custom AR tours using a browser. 

●​ Define POIs for the tour on a map. 

●​ Attach 3D models, images, audio, video and documents to POIs. 

●​ Add multilingual explanatory text and audio associated with the POI and its connected assets. 

●​ Preview tours before deployment. 

●​ Test the tour you prepared on-site by using the accompanying AR Tour Experience app 

THIS GUIDE IS INTENDED FOR 
This guide is intended fo: 

●​ Curators and cultural heritage professionals of heritage sites 

●​ Archives working with urban or landscape heritage 

●​ Educators 

●​ Tourism and local heritage stakeholders 

BEFORE YOU START, YOU NEED 
●​ A computer with a web browser 

●​ Internet connection 

●​ Access to open content assets hosted on an online platform (3D models, images, audio, texts) 

●​ Optional: a draft or idea for a site or a route you want to tell a story about in AR  
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OVERVIEW OF THE WORKFLOW 
The overall workflow involves the following steps: 

1.​ The user creates a new project in AR Tour Builder. 

2.​ They add Points of Interest (POIs) on a map. 

3.​ A set of items of various formats, including 3D models, images, textual documents, and links can be 

added to each POI. 

4.​ Short textual and audio explanations can be added as metadata in the desired language(s). 

5.​ The tour can be tested on-site via the accompanying AR Tour Experience mobile app. 

STEP-BY-STEP GUIDELINES 

HOW TO ACCESS THE AR TOUR BUILDER? 
 

The AR Tour Builder is available via these links: 

●​ Demo web tool version available on: https://eureka.ails.ece.ntua.gr/  

●​ Production version available on: artourbuilder.eureka3dxr.fedcloud.eu 

 

HOW TO LOGIN? 
 

The first step to get access to the AR Tour Builder is to register in EGI Check-in. The process to register your 

account is as simple as performing a log in with your usual account. Check-in allows users to authenticate 

with any organisation adhered to eduGAIN, including Universities, academic federations and research 

institutions, as well as with the so-called “social” identity providers such as Google, LinkedIn or ORCID, as 

shown in the image below.  
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https://eureka.ails.ece.ntua.gr/
http://artourbuilder.eureka3dxr.fedcloud.eu


 

 

 

 

 

 

 

Figure 1 EGI check-in 

  

The second step is to join the EUreka3D Community. For this, you need to send a request for approval by 

visiting the following link: https://go.egi.eu/join_eureka3d  

Both processes, the registration in Check-in and the request to join the community, are documented in 

Section 2 of the Content Provider Handbook, available at: https://go.egi.eu/eureka3d_handbook 

Once you have completed the aforementioned process with your preferred account, you will be redirected 

to the My Projects page of the AR Tour Builder. 
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https://go.egi.eu/join_eureka3d
https://go.egi.eu/eureka3d_handbook


 

 

 

 

 

 

HOW TO CREATE A NEW PROJECT? 
 

Once you log in you will be redirected to My projects page, where you can see all the projects you are part 

of.  

 

Figure 2 My projects page 

 
What do you see on the My Projects page? 
 
The My Projects page shows all your projects. On this page you get an overview of the projects, the 
associated data, such as the tours, number of POIs and assets, etc. 
 
By clicking on a project, you get redirected to the project’s dashboard, displaying project associated data 
like its tours and members. 
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In order to create a new project, select New Project. A stepper form will open in order to fill in the 

necessary information.​
 

First you need to specify the languages the project will support, which are basically the available languages 

the curators will be able to add content. 

​

 

Figure 3 Create a new project; select language 

In the next steps you will be prompted to enter the project name and a description, ideally in the languages 

you selected in the previous step, as well as some branding like a logo and cover photo.  

Branding is optional, but will help a lot with the visual representation of the project when presented in the 

AR Tour Experience mobile app.  
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Figure 4 Create a new project; Add basic information 

 

Figure 5 Create a new project; Branding 
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Once you fill in the form and click Save, your project is created and you will be redirected to the project’s 

Dashboard. 

 
What do you see on a project’s Dashboard page? 
 
The Dashboard page shows basic project information, as well as the tours and members contained in it. 
 
The dashboard page acts as the main navigation hub, giving access to the project's Tours, Settings, and 
Members sections, allowing you to manage tour content, update project information, and handle team 
collaboration all from one place. 

Tip - you can create multiple tours under one project 

 

HOW TO CREATE A NEW TOUR? 

1.​ Open the My Projects page and select the project 

2.​ Go to Tours, by either selecting Tours Editor from the sidebar on the left or See all from the tours 

table inside the dashboard 

 

Figure 6 Tour overview 

 

3.​ Choose ‘Create new tour’ 
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Figure 7 Create a new tour 

 

4.​ Fill in the form with the tour’s basic information: 

a.​ Tour name (multilingual) 

b.​ Description (multilingual) 

c.​ Estimated duration 

d.​ Estimated distance 
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Figure 8 Input screen for a new tour​
 

After creating the tour, you will be prompted to start adding points of interest to the tour. 

 
What do you see on a Tour page? 
 
The Tours page consists of two navigation sections:  
 

1.​ Tour Information displaying the basic Tour info (description, time estimation etc.) and  
2.​ Points of interest. In case of guided tours, the POIs are sorted.  
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HOW TO ADD POINT OF INTEREST (POI) TO A TOUR AND ASSIGN CONTENT? 
 

1.​ Open the POI form 

a.​ Open the tour from the Tours Editor page 

b.​ Enter the Points of Interest tab 

c.​ Click ‘Add POI’ 

d.​ A sidebar with the POI’s form will appear from the right containing tabs to enter different 

categories of POI’s information 

 

Figure 9 Add POI 

 

2.​ Enter the POI location  

a.​ Click on the map to place a pin or add the coordinates directly on the inputs below the map 

b.​ Drag the pin in order to update the POI’s location, you will see the coordinates updating at 

the same time below. 

c.​ When ready, click Next Step 
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Figure 10 Add POI Location 

 

3.​ Describe the POI 

a.​ Add details 

●​ Title (multilingual) 

●​ Description (multilingual) 

●​ Radius, the distance where the visitor gets an indication of reaching the POI. 

●​ Cover photo (optional but recommended) 

b.​ Click Next step 
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Figure 10 Add POI Information 

 

4.​ Add external links 

a.​ You can add external links like Quiz or Blog posts  

b.​ You can also define different links per language, since each quiz/blog post link will probably 

be written in specific language 

c.​ When ready click Create and add media. This saves the POI and redirects to the Media step 

to start adding media assets to the POI. 
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Figure 11 Add external links and media to the POI  

 

5.​ Attach assets to the POI 

a.​ Go to Media tab 

b.​ Click Add 

c.​ Select between creating a new asset or selecting one from your library 
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Figure 12 Attach asset to POI  

 

6.​ Select and import an asset from your library 

a.​ Select an asset from your library 

b.​ The form will be prepopulated with this asset’s information 

c.​ Continue editing the form and click Save​
 

7.​ Create an asset from scratch 

a.​ Fill in basic information like 

i.​ Title 

ii.​ Description 

iii.​ Set the asset as the primary asset of the POI. By toggling this option the asset will 

be showcased prominently in the mobile app when the visitor views the POI’s 

information.  

iv.​ Select Media Type 

v.​ Add the media url 

b.​ In case of a 3D media asset, fill in additional information 
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What is the library? 
 
The library offers an overview of all the assets that a user manages in the tool. Assets include 3D models, 
images, videos, etc. For each asset you find information on the name, type, size etc. 
 
In this view you can preview, edit and delete assets. 
 

 

HOW TO MANAGE 3D CONTENT? 
 

Adding 3D content requires the following: 

1.​ Find a POI where you want to associate the 3D content 

2.​ Create an asset of type 3D and assign it to the POI 

Then you can choose the 3D content: 

1.​ Availability in AR mode 

2.​ Georeference, whether to appear in AR at a specific real-world location 

3.​ Rotation, scale and positioning using our 3D editor  

4.​ Optional linked audio 

 

Figure 13 Detail asset page  
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Clicking Edit 3D Properties opens a dedicated 3D editor where you can precisely manipulate the model's 

position, rotation, and scale in real-world coordinates. 

The editor provides the following tools and references: 

●​ Gizmo controls — Use the on-screen gizmo to Translate or Rotate the model interactively by 

dragging along the colored axes (X, Y, Z). 

●​ Ground grid — A reference grid is displayed beneath the model, where each cell represents 1×1 

meters, giving you an accurate sense of real-world scale. 

●​ Compass indicator — A compass bar at the top of the viewport helps you orient the model relative 

to true cardinal directions (N, NW, etc.). 

●​ Properties panel — A panel on the right displays the current numeric values for Position, Rotation, 

Scale, and Dimensions (in meters), updating in real time as you manipulate the model. 

Once you are satisfied with the placement and orientation, click Save Transform to apply the changes, or 

Cancel to discard them. 

 

Figure 14 3D editor  
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HOW TO PUBLISH A TOUR IN THE AR TOUR EXPERIENCE? 
 

1.​ Open a tour’s page 

2.​ Click Publish, top right of the page 

 

Figure 15 Publish the tour  

 

HOW TO UPDATE A TOUR? 
 

1.​ Open a tour’s page 

2.​ Modify the tour’s information or POIs and click Save Changes 

 

HOW TO MANAGE A PROJECT’S ASSETS LIBRARY? 
 

1.​ Select a project 

2.​ From the sidebar on the left, select Library 

3.​ In the library page you can: 

a.​ See all your assets 

b.​ Filter assets by type 

c.​ Create new assets, able to reuse them when adding content to a tour’s POI. 
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Figure 16 Asset library 

 

MORE INFORMATION 
 

 
●​ Source code on Github: https://github.com/EUreka3D-XR/AR-Tour-Builder 

●​ API (documented in Swagger): https://eureka.ails.ece.ntua.gr/api/docs/  

●​ Demo version: https://eureka.ails.ece.ntua.gr/  

●​ Production version: artourbuilder.eureka3dxr.fedcloud.eu 
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INTRODUCTION 
This step-by-step guideline provides an overview of the main capabilities provided by the AR Tour 

Experience mobile app.  

 

By following this guide, you will be able to: 

●​ Load custom AR tours in outdoor heritage contexts created via the AR Tour Builder on a mobile 

device 

●​ Learn about the main Points Of Interests associated with the tour, based on your GPS location 

●​ Gain access via a multilingual user interface to various assets associated with a POI (including 3D 

objects, images, text etc) 

●​ View 3D models in overlay AR using the mobile device’s camera 

THIS GUIDE IS INTENDED FOR 

●​ Visitors interested in exploring a location at their own pace 

●​ Pupils, students, and other guided groups 

●​ Site mediators and tour guides 

BEFORE YOU START YOU WILL NEED 
●​ Smartphone with camera (Android) and AR capabilities 

●​ GPS access 

●​ Sufficient internet connectivity (depending on content setup) 

 

You can find more about the supported Android devices with AR capabilities along with a list of devices 

here: https://developers.google.com/ar/devices. 

OVERVIEW OF THE WORKFLOW 
The overall workflow involves the following steps: 

1.​ The visitor opens the AR Tour Experience app and selects their desired AR tour. 

2.​ As the visitor explores the site, they are prompted about nearby POIs. 

3.​ Moving to a POI, the app presents to the visitor a selection of relevant objects associated with the 

respective location. 

4.​ The visitor can choose to visualise a 3D object in overlay AR mode, thus being able to inspect 

hidden or missing elements at the location. 

5.​ The app provides additional rich content (including images, textual documents, links to external 

resources such as a quiz), allowing the visitor to explore the location context more deeply. 
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Figure 1 The AR Tour Experience in action in the Bibracte archaeological site. 

STEP-BY-STEP GUIDELINES 

HOW TO DOWNLOAD THE APP? 
​
You can download and install the app from Google Play: link  

HOW TO SELECT A TOUR? 

Upon opening the app, you will see a list of available archaeological projects.  

1.​ Tap the arrow button on a project card to enter it. You will then see the project's description along 

with its available tours.  

2.​ Tap See More on any tour card to open its detail page, where you can read the full description and 

browse its Points of Interest (POIs). 
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Figure 2 Project cards in the AR Tour Experience  
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HOW TO DOWNLOAD TOUR’S CONTENT FOR OFFLINE USE? 
 

On the tour detail page, tap the Download Tour button to save the tour's content to your device. This allows 

you to access all tour information, media, and POIs without an internet connection while on-site. 

 

Figure 3 Tour detail page  
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HOW TO SELECT A LANGUAGE? 
 

1.​ At any point during an ongoing tour, tap the Settings icon (⚙️) in the top-right corner of the screen. 

2.​ A Settings panel will appear where you can select your preferred language from the dropdown 

menu.  

3.​ The app content will update accordingly. 

 

Figure 4 Settings 

 

HOW TO ENTER A TOUR AND NAVIGATE? 
 

On the tour detail page, tap Start Tour to begin. You will be taken to an interactive map view showing the 

tour area with all POIs marked as icons on the map. You can: 

1.​ Tap a POI icon on the map to select and open it. 

2.​ Tap All POIs in the top-right corner to open a full list of all Points of Interest, and tap the location 

icon next to any entry to center the map on it. 

3.​ Use the location button in the bottom-right corner to re-center the map on your current position. 
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Figure 5 Left: map view. Right: Overview list of POIs 
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HOW TO VIEW A POI AND ITS CONTENT? 

Tapping on a POI opens its dedicated page, where you can read its historical description and explore all 

associated media, organised by type: 

●​ Photos — Archaeological photographs and artefact images. 

●​ Videos — Documentary or contextual video clips. 

●​ 3D Models — Interactive 3D reconstructions viewable directly in the app. 

●​ Quiz — An optional quiz to test your knowledge about the site. 

Scroll down to browse all available content, and tap any media item to open it in full view. 

 

Figure 6 Associated media 
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HOW TO ENTER AN AR EXPERIENCE? 

When viewing a 3D Model, you will be taken to the 3D Model Viewer screen, where you can rotate and 

inspect the model interactively. To place the model in the real world using Augmented Reality, tap the AR 

button in the top-right corner of the viewer. Your camera will activate and allow you to position the 3D 

model in your physical surroundings for an immersive, true-to-scale experience. 

MORE INFORMATION 
 
 

 
●​ Source code on GitHub: 

https://github.com/EUreka3D-XR/AR-Tour-Experience 

https://github.com/EUreka3D-XR/AR-Tour-Builder-backend 

●​ Demo video at the Bibracte archaeological site (Jan 2026): Link 
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INTRODUCTION 
 

This step-by-step guideline introduces the AI 3D Builder, a workflow designed to help users generate 3D 

models from images using AI-based tools and refine them for use in XR, web, or research environments. 

The guide focuses on accessible, practical steps, allowing Cultural Heritage professionals and content 

creators to transform 2D images into usable 3D assets without requiring advanced technical expertise. 

By following this guide, you will be able to: 

●​ Prepare images for AI-based 3D generation 

●​ Generate a 3D model using an AI tool 

●​ Clean and optimise the model in Blender 

●​ Create and apply textures 

●​ Export a final model ready for visualisation 

THIS GUIDE IS INTENDED FOR 
●​ Cultural Heritage professionals 

●​ Archivists and researchers 

●​ XR and creative professionals 

●​ Anyone interested in AI-based 3D modelling 

No programming skills are required. Basic familiarity with images and files is sufficient. 

TOOLS AND SOFTWARE USED IN THIS GUIDE 
For both 2D images and 3D models editing, any possible software can be used but this guideline will show 

the use of respectively Photopea and Blender for them, both accessible for free. 

●​ Photopea (web-based)  for image preparation and editing 

○​ Download link: https://www.photopea.com/?utm_source=homescreen  

●​ Trellis (web-based AI tool) for generating 3D models from images 

○​ Download link: https://huggingface.co/spaces/Trellis-community/Trellis 

●​ Blender (desktop application) for cleaning, editing, and exporting models 

○​ ​​https://download.blender.org/release/Blender4.2/blender-4.2.2-windows-x64.msi 

BEFORE YOU START, YOU WILL NEED 
●​ A computer (Windows, macOS, or Linux) 

●​ Internet access 

●​ Basic image files of the object you want to model 

●​ Optional materials 

○​ Multiple images of the object (recommended for better results) 

○​ High-resolution photos  
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PREPARATION OF YOUR MATERIALS AND WORKSPACE 
●​ Organise your project into folders: 

○​ Input images (original and cleaned) 

○​ AI-generated models 

○​ Blender project files 

○​ Final exported models 

●​ Ensure that: 

○​ Images clearly show the object of interest 

○​ Background elements are minimised or removable 

○​ The object is visible from different angles (if possible) 

OVERVIEW OF THE WORKFLOW 
The AI 3D Builder workflow consists of four main stages: 

1.​ Image preparation in Photopea: isolate and clean the object in images  

2.​ 3D model generation in Trellis: use AI to create the model  

3.​ Model correction in Blender: refine geometry and fix errors  

4.​ Texture preparation in Photopea  

5.​ Texturing and export in Blender: apply textures and prepare final output  

 

 

Figure 1 Overview of the workflow 
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STEP-BY-STEP GUIDELINES 
 

STEP 1: IMAGE PREPARATION (PHOTOPEA) 
The images to be provided as input to the AI Tool (Trellis) for modeling must first be specifically prepared. 

Therefore, it is necessary to ensure that the AI Tool focuses its attention exclusively on the object we wish to 

reproduce, leaving out anything superfluous or likely to generate errors (trees, vegetation, street furniture, 

etc.). 

The background must be removed, leaving only the object of interest. The tool is able to perform this 

procedure automatically; however, the background removal algorithm is not so effective in the case of 

images with many details or with excessively uniform colors. It's important to remove as many unwanted 

elements as possible to obtain a final product that requires minimal manipulation. If this isn't possible, you 

should still try to correctly cut out the object of interest, so as to provide the AI tool with its general shape. 

WHAT IS PHOTOPEA? 
Photopea is a free, browser-based image editing tool used to prepare images before processing them with 

AI tools. 

📺 WATCH THE DEMO VIA THIS LINK: IMAGE PREPARATION (PHOTOPEA) 

 

HOW TO PREPARE YOUR IMAGES? 
 

1.​ Open Photopea  

2.​ Upload your image (File → Open) 

 

Figure 2 Uploads in Photopea 
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3.​ Remove the background: 

a.​ Use the Lasso tool  

i.​ The default option is Lasso Select. To be able to select the object, the option 

Polygonal Lasso is recommended; this option can be accessed by long-pressing the 

Lasso tool and selecting Polygonal Lasso Select. 

 

Figure 3 Lasso tool​ ​ ​ ​ ​ Figure 4 Polygonal Lasso Select  

 

b.​ Once the object’s shape is defined, invert the selection: go to Select → Inverse 

i.​ The selection will now include all the objects to be deleted, except the object we're 

interested in.  

 

Figure 5 Inverse in Photopea 

c.​ To remove the unwanted items, press the DELETE button on your keyboard. 

​
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4.​ Export the image: 

a.​ File → Export As … → PNG 

The resulting images must be saved in .PNG format to preserve the transparency of the removed image 

portions. Saving in .JPG format automatically fills the deleted portions with white, which could cause 

calculation errors in the AI Tool. 

Important: Clean images significantly improve AI-generated results by reducing unwanted artefacts. 

 

Figure 6 Export path in Photopea 
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STEP 2: 3D MODEL GENERATION (TRELLIS) 
 

WHAT IS TRELLIS? 

Trellis is an AI-based web application that generates 3D models from one or more input images. To use the 

3D model generation tool, go to https://huggingface.co/spaces/Trellis-community/Trellis. The web app 

interface will open. 

 

Figure 7 Trellis web interface 

 

📺 WATCH THE DEMO VIA THIS LINK: 3D MODEL GENERATION (TRELLIS) 

 

 

 Grant Agreement n. 101174054​ ​ 8 

 

https://huggingface.co/spaces/trellis-community/TRELLIS
https://www.youtube.com/watch?v=t3G7SCZ3jBU


 

 

 

 

 

 

UPLOADING YOUR IMAGE(S) AND CONFIGURATION 

1.​ Open Trellis in your browser.​
 

2.​ Upload one or multiple images that need to be computed for 3D model creation. 

○​ Do this in the left upper section ‘Image prompt’ of the interface. (figure 7) 

○​ You can drag and drop images, or by uploading them from your computer. 

○​ If you opt to compute multiple images, select the Multiple images tab. Keep in mind that 

this is an experimental feature and may not always provide the expected results. 

​
Figure 8 Trellis upload screen 

3.​ Configure Generation settings: 

○​ Do this in the middle section on the left. (figure 7) 

GENERATION SETTINGS 

●​ Seed: The "seed" value establishes a random configuration for the 3D model generation.  

For the other parameters it is better to stick to the following values, so the model can be generated 

following the input images as faithfully as possible. The general guideline is that the higher the value set 

for each parameter, the less room for free interpretation by the A there will beI. 

●​ Stage 1: Sparse Structure Generation 
○​ Guidance Strength: 10 

○​ Sampling Steps: 50 

●​ Stage 2: Structured Latent Generation 
○​ Guidance Strength: 10 

○​ Sampling Steps: 50 

●​ Multi-image Algorithm: Stochastic 
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4.​ Configure GLB Extraction settings 

○​ Do this in the bottom section on the left. (figure 7) 

○​ These settings allow you to set the parameters for saving the 3D model, with the option to 

save it in .GLB or Gaussian (.PLY) format. The Gaussian PLY (Polygon File Format) is a 

technology that uses points instead of traditional polygons to represent 3D models. It 

enables a lighter, more detailed, and dynamic representation of materials, textures, and 

reflections. 

GLB EXTRACTION SETTINGS 

●​ Simplify: 0.98 
●​ Texture Size: 512 

 
Important: Depending on the degree of fidelity desired compared to the input images, the parameters are 
set accordingly: if the goal is to obtain a model that adheres as closely as possible to the input images, the 
parameters should be set to the maximum; conversely, if the AI Tool is preferred to have greater freedom of 
interpretation, the parameters can be set to intermediate values or to the minimum. 

3D MODEL CREATION AND EXPORT 

1.​ Click Generate & Extract GLB to start the model creation process. Wait for the mesh to calculate. 

2.​ The model is displayed in the Generated 3D Asset section (as a panoramic video; upper right 

section, see figure 7) and in the Extracted GLB/Gaussian section (as a real-time view; lower right 

section, see figure 7).  

3.​ Click Download GLB to export the resulting model. 

Tip: Using multiple images improves accuracy but may produce inconsistent results depending on quality. 
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STEP 3: FIXING THE 3D MODEL (BLENDER) 
​
The model calculated by the AI Tool, in most cases, never turns out as expected: there are always 

imperfections resulting from an erroneous interpretation by the AI or objects that could not be eliminated 

during the cleaning phase of the images supplied as input to the Tool. It is therefore necessary to 

manipulate the generated object in order to eliminate everything that is not necessary and leave only the 

desired object. However, often eliminating these artifacts creates gaps that must be rebuilt from scratch, 

creating vertices, edges, and faces.  

To fix the object, the 3D object manipulation software Blender is used. 

​
Figure 9 Blender web interface 

WHAT IS BLENDER? 
Blender is a free, open-source 3D software used for editing, cleaning, and optimising 3D models. 

📺 WATCH THE DEMO VIA THIS LINK: FIXING 3D MODELS (BLENDER) 

​
BASIC COMMANDS IN BLENDER 
Once installed, the software welcomes the user with an introductory screen that allows them to select the 

interface language, choose a tool preset, view recently opened files, and open the file browser to select an 

existing file. 

Key Function 

Left Mouse Button (LMB) Select an object in the scene 

SHIFT and LMB Select multiple objects 

LMB and drawing a window from left to 
right 

Select all the objects inside the selection window 

Right Mouse Button (RMB) Open the context menu 

Middle Mouse Button (MMB) Orbit View 

SHIFT and MMB Pan View 

CTRL and MMB Zoom View 
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Mouse Wheel Zoom View In or Out 

X Delete the selected item with a confirmation dialog. 

Del or Canc or Delete Delete the selected item without a confirmation dialog. 

M Merge objects/vertices/edges/faces 

TAB Switch Object/Edit Mode 

G Grab the selected object 

 

HOW TO IMPORT THE 3D MODEL? 
1.​ Delete any preexisting models in Blender before import. 

a.​ Select the existing objects while holding down SHIFT, or by clicking on the models or 

selecting them by dragging. 

b.​ Press DELETE on your keyboard. 

c.​ You are left with an empty scene with the Cartesian X (red) and Y (green) axes. 

 

Figure 10 Empty scene in Blender 

To import a model 

1.​ Click File → Import → select file type 

a.​ Models from Trellis have a .GLB extension. Choose glTF 2.0 (.glb/.gltf). 

2.​ Select your generated model and click Import glTF 2.0. 
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Figure 11 Import path in Blender 

HOW TO CLEAN THE MESH? 

Remove unwanted geometry 
1.​ Select the object.​

 

2.​ Enter Edit Mode (press TAB on keyboard). 

a.​ In Edit Mode, to the right, there are 3 buttons: the selection filter with Vertices, Edges and 
Faces respectively. 

 

Figure 12 Filters in edit mode in Blender 

b.​ These allow you to manipulate, create, and delete vertices, edges, and faces.  

3.​ Select the filter ‘vertices’. 
4.​ Select the vertices in the 3D model that need to be deleted. 

a.​ Hold down the SHIFT key on the keyboard for multiple selections. 

5.​ Press the DELETE key on the keyboard.  

a.​ This will leave gaps that will be filled in during the next step. Figure 13 below is an example 

of error deletion. 
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Figure 13 Example of error deletion 

​
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Close gaps 
When eliminating errors resulting from the 3D generation process, it often happens that some of the 

eliminated faces belong to the surface of the object in question. Removing the faces leaves gaps that can 

be restored without affecting the overall shape of the object.  

1.​ Select the 3D model 

2.​ Enter Edit mode 

3.​ Select Vertices filter​

 

4.​ Select the three vertices of the gap 

5.​ Press F on your keyboard to create a polygon 

6.​ Repeat for the other gaps 

Tip: When two or more vertices are too close to each other, you can merge them by pressing the M key on 

the keyboard. Pressing M opens a context menu that allows you to determine how the vertices are merged. 

 

Figure 14 Example of closing gaps in Blender 

Important: The texture will appear out of place; this is because the existing texture mapping is based on the 

mesh generated by Trellis. Once surface reconstructions are performed on the mesh, the reference to the 

existing mapping is lost. However, this isn't a problem, as the texture will be replaced later and the mapping 

will be done manually again. 
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Moving or merging vertices 
Deleting a face may also leave vertices without any connection to other vertices. Furthermore, you may 

want to reduce the number of polygons of the generated model by eliminating excessively small ones and 

reconstructing them by joining their vertices to others belonging to other polygons. It is therefore necessary 

to intervene on individual vertices. Vertices are moved as with any other object in the scene, provided you 

first enter Edit Mode. 

1.​ Select Vertices filter​

 

2.​ Move vertices 

a.​ Select the vertex you want to move 

b.​ Press the G key on your keyboard to begin the movement 

i.​ You can constrain the movement along one or more axes after pressing the move 

key: click the X, Y, Z keys on the keyboard to move the elements along a single 

Cartesian axis or SHIFT+X, Y, or Z on the keyboard to move the elements on a plane. 

3.​ Merge vertices 

a.​ Select the vertices you want to merge, by holding down SHIFT and clicking on the individual 

vertices. 

b.​ Press M (merge) on your keyboard. 

c.​ A context menu opens 

i.​ Choice a vertex merging mode  

 

Figure 15 Context menu for merging vertices 
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STEP 4: TEXTURE PREPARATION (PHOTOPEA) 

During model generation, Trellis is able to create a texture from the photos it receives as input. If only a 

single photo is provided, Trellis interprets the missing information using the database of photos used for 

training. When multiple images are provided, the AI tool attempts to interpolate all the information to meet 

the reliability parameter settings set before generation. Sometimes, however, the texture content is 

generated arbitrarily, and the resolution is not high enough to be considered optimal in most cases. It is 

therefore necessary to create a texture manually from locally available images.  

The main operations involved in creating the texture are:  

●​ compositing multiple images,  

●​ eliminating unnecessary details,  

●​ straightening to correct perspective aberration, 

●​ balancing brightness and contrast. 

📺 WATCH THE DEMO VIA THIS LINK: TEXTURES PREPARATION (PHOTOPEA) 

 

IMPORT IMAGES FOR TEXTURE 
1.​ Open Photopea 

2.​ Import images into Photopea 

a.​ Select ‘Open from computer’ 

b.​ Select the image you want to modify 

Tip: Use an image taken as close to the object as possible, so as not to lose details. 

IMAGE CLEANING 
1.​ Select the area you want to clean 

a.​ You can use Rectangular selection, Lasso selection (normal, polygonal, magnetic) or Magic 

Wand selection. 

2.​ Press DELETE on your keyboard to delete the selected area 

3.​ To fill in the empty area 

a.​ Option 1 

i.​ Right click on the selection 

ii.​ Choose ‘Fill’. It will open a dialog window to select the filling method 

iii.​ Choose ‘Content aware’ 
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Figure 16 Filling method in Photopea 

 

b.​ Option 2: the Clone tool 

i.​ Select an existing part of the image you want to copy 

ii.​ Select the Clone tool 

iii.​ Copy the content to the empty area you first cleaned. 

 

Figure 17 Clone tool in Photopea 

STRAIGHTENING FOR PERSPECTIVE ABERRATION CORRECTION 
In some cases, such as when taking a photo of a tower, the image appears distorted due to the curvature of 

the tower itself. Since it isn't a flat surface, it's not possible to use the photo as a basis for creating a texture. 

It's therefore necessary to straighten the image to obtain a "flat" image that can be used as a texture. The 

first step involves isolating a section of the photo where the shooting point is perpendicular to the surface 

of the tower. 

1.​ Use the Trim tool. 

2.​ Crop the image.  

a.​ The crop should result in an image with a 1:1 aspect ratio, preferably. 

3.​ Isolate the section deemed suitable for creating the texture. 
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Figure 18 Trim tool in Photopea​     ​          Figure 19 Crop for texture with 1:1 ratio in Photopea 

 

4.​ Now straighten the photo to obtain a flat texture 

a.​ Go to Edit → Transform → Warp tool. 

i.​ ​​The image will be surrounded by squares and dots on the edges of the image 

b.​ Drag the grips to straighten the image 

 

Figure 20 Warp tool in Photopea 
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Figure 21 Left: before straightening. Right: result after straightening in Photopea 

 

BRIGHTNESS AND CONTRAST 
The image you just obtained, may have lighter or darker areas due to shadows or uneven sunlight. This 

causes the appearance of cuts, even abrupt ones, when applying the texture to the final object. To prevent 

this behavior, the texture must be modified to make the brightness and contrast uniform. 

1.​ Go to Image → Adjustments → Brightness/Contrast…​
 

2.​ Adjust brightness and contrast ​
 

3.​ Click ‘OK’ 

 

Figure 22 Path to adjust brightness and contrast in Photopea 
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CREATE SEAMLESS TEXTURES 
In the previous step, a texture was created that can be repeated multiple times across the entire surface. 

However, this repetition can cause visible sharp cuts that break the surface's continuity, making the model 

unrealistic. To create a seamless texture from an image, you must first translate it horizontally and 

vertically to see how repetition can affect the final result. 

1.​ Go to Filter → Other → Offset…​
 

2.​ Move the image horizontally and vertically by an amount equal to half the resolution. 

a.​ To know the image resolution, go to Image → Image Size and note the resolution. 

 

Figure 23 Left: path for offset. Right: path to retrieve image size in Photopea 

 

Figure 24 Offset command in Photopea 
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By performing the Offset command, you may notice that the connection between one repetition and the 

next has discontinuities. Once you confirm the move, you must then adjust each image in the repeated 
areas, proceeding as described above in the Image Cleaning section. 

 

Figure 25 Offset command in Photopea 

Once you've fixed the seams between each repetition, you can reset the image's positioning with the Filter 
→ Other → Offset command and move the image horizontally and vertically by an amount equal to half 

the resolution in negative value. So considering the same image, you need to move it horizontally and 

vertically by -1500 pixels. 

TEXTURE EXPORT 
To export the texture, click File → Export As... → PNG 

 

Figure 26 Export path in Photopea 
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STEP 5: APPLY THE TEXTURE TO THE 3D MODEL (BLENDER) 
​
The final step involves applying the newly created texture to the model obtained previously after the mesh 

cleaning operations. The application that allows you to perform this operation is once again Blender. After 

opening a new project and deleting the default objects from the scene, you need to import the model to 

which you want to apply the texture. 

📺 WATCH THE DEMO VIA THIS LINK: APPLYING TEXTURE TO THE 3D MODEL (BLENDER) 

 

IMPORT THE 3D MODEL 
1.​ Go to ‘File’ 

2.​ Select ‘Import’ 

3.​ Select the file type 

a.​ Models output to Trellis have a .GLB extension, so you need to select glTF 2.0 (.glb/.gltf). 

4.​ Choose the desired file from your browser 

5.​ Select Import glTF 2.0. 

 

Figure 27 Import path in Blender 

MATERIAL CREATION AND TEXTURE IMPORT 
1.​ Select the Material view mode in the right sidebar 

a.​ The model generated by Trellis already has a material with an assigned texture. You can edit 

the existing material or delete it and create a new one. 

2.​ Expand the Surface section 

3.​ Click the arrow next to the Base Color entry 

a.​ Under Base Color you will see that a texture has already been assigned. This is the one 

assigned by Trellis during the 3D model generation. 

b.​ To replace it with the one created with the previous step, click the cross on the left next to 

the file name. The display will now change. 

4.​ Click ‘Open’ to open the file browser that allows you to load the texture you created in Photopea.  
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Figure 28 Material view mode in Blender​ Figure 29 Surface section in Blender 

5.​ Click ‘Open image’. 

a.​ It is immediately applied to the entire model, but not uniformly, as you can see below.  

b.​ To solve this problem, you need to perform a correct UV mapping, which is described 

further in this manual. 

 

Figure 30 Result after uploading a new texture file 

 

6.​ If your object must be opaque, set the value of the Metallic parameter to 0 (the default setting is 1). 
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APPLYING TEXTURED MATERIAL AND CORRECT POSITIONING 
​
Once you have created the material and adjusted its parameters (such as roughness, gloss, or colour), you 

can apply it either to the entire mesh or to selected parts of the model. By default, a material is assigned to 

the whole object, but this can be refined depending on your needs.  

If you only want the material to affect specific areas:  

1.​ Select the model 

2.​ Go to Edit Mode 

3.​ Use the Faces filter to select all faces you want to assign the material​

 

4.​ In the Material tab: select the desired material and click ‘Assign’. 

 

Figure 31 Assign a Material to a face 

Note: The texture will be displayed incorrectly, as it needs to be mapped, which is described in the 

next step. 

UV mapping 
UV mapping is necessary to tell Blender how to distribute the texture across the model's surfaces. When 

calculating the model, Trellis can map the texture that is generated concurrently; changing the texture 

doesn't always mean the same mapping can be used. 

Take a look at this example​
You may notice that the texture you want to assign fills each polygon randomly. Since this isn't what you're 

looking for, you need to recalculate the mapping so that the texture is applied to the entire model in an 

orderly fashion, rather than to individual polygons. 

 Grant Agreement n. 101174054​ ​ 25 

 



 

 

 

 

 

 

 

Figure 32 Example of a misaligned texture an a model before UV mapping 

 

For UV Mapping 

1.​ Enter Edit mode 

2.​ Set the Face filter​  

3.​ Press ‘A’ on your keyboard to select all faces 

4.​ Click right to open the context menu 

5.​ Select ‘UV Unwrap Faces’ → ‘Unwrap’ 

​​This way, the entire surface of the model is wrapped around the texture. 

 

Figure 33 Context menu for unwrapping the model 

From this point, you can intervene in two ways: 

Option 1: if the object has a complex volume 

1.​ Right click with all faces selected 

2.​ In the context menu select UV Unwrap Faces → Smart UV Project  

It cuts the mesh based on an angle threshold (angular changes in your mesh). This gives you fine 

control over how automatic seams are created. It is a good method for simple and complex 
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geometric forms, such as mechanical objects or architecture. This algorithm examines the shape of 

your object, the faces selected and their relation to one another, and creates a UV map based on 

this information and settings that you supply. 

 

 
Figure 34 Smart UV Project 

Option 2: if the object has a regular shape (cube, cylinder, sphere) 

1.​ Right click with all faces selected 

2.​ In the context menu select UV Unwrap Faces → Cube/Cylinder/Sphere Projection 

a.​ This way, a mapping already adapted to the shape is applied. 

 

Figure 35 Cube/Cylinder/Sphere Projection 

EXPORTING THE FINAL MODEL 
The final step is to export the newly created model in a format compatible with the EUreka3D-XR Project 

tools. 

1.​ Select the 3D model 

2.​ Click File → Export → glTF 2.0 (.glb/.gltf) 
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Figure 36 File export path 

 

Important: Inside the file browser it is important to expand the Include section drop-down menu and check 

the Limit to Selected Objects option, otherwise objects outside of the one of interest could be exported. 

 

Figure 37 File browser for export 
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1.​ INTRODUCTION 
This step-by-step guide explains how to use the 3D XR Studio, a web-based authoring platform for creating 

immersive XR experiences. It is designed specifically for cultural heritage professionals and curators who 

want to bring history to life for their audiences, without the need for advanced technical skills. 

By following this guide, you will be able to:  

●​ Create a new XR project in the 3D XR Studio web component 

●​ Define a geographical area and import 3D models within it 

●​ Design a guided tour with points of interest, narratives, and multimedia 

●​ Fine-tune the placement of 3D models using the mobile component 

●​ Share the experience with visitors on their phones via a downloadable app​
 

THIS GUIDE IS INTENDED FOR 
●​ Cultural heritage professionals, archivists and museum curators 

●​ Researchers involved in digital heritage projects 

BEFORE YOU START YOU WILL NEED 
●​ A computer with a web browser 

●​ Valid credentials to access the 3D XR Studio (compatible with the EGI Single Sign-On) 

●​ Your 3D models ready (GLB format recommended), along with any images, videos, or audio files you 

wish to include 

●​ A smartphone (compatible with Google ArCore) if you plan to use the on-site fine-tuning 

functionality via the mobile component​
 

PREPARATION OF YOUR MATERIALS AND WORKSPACE 
Before opening the 3D XR Studio, prepare the following materials: 

●​ 3D Models: Export them in GLB format. Optimise polygon count for mobile rendering. 

●​ Images: JPG or PNG files to be used as information panels or decorative elements. 

●​ Audio files: most common formats, for narration. 

●​ Video files: most common formats, short clips (keep file sizes reasonable for download). 
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2. OVERVIEW OF THE WORKFLOW 
 

Step 1 – Plan Select your media assets and decide the scope of your XR 
experience (which area, which 3D models, which narrative). 

Step 2 – Create Log in to the web component, create a new project and 
configure the area on the map. 

Step 3 – Build Import 3D models, place them in the virtual environment, and 
set coordinates, orientation, and scale. 

Step 4 – Narrate Define the guided tour route by placing path points. Add 
points of interest and associate media to each of them (text 
descriptions, audio, video, images). 

Step 5 – Totem Set up physical totems with QR codes at the site. 

Step 6 – Refine Use the mobile component on-site to fine-tune model 
placement and validate the experience in Augmented Reality. 

Step 7 – Visit Visitors download the app, scan the QR code, and enjoy the 
AR experience. 

3. STEP-BY-STEP GUIDELINES 
 

3.1 PREPARE YOUR ASSETS 
 

STEP 1 Gather and Organise Your Media 
Collect all content before opening the tool. 

 

Before accessing the 3D XR Studio web component, prepare the following materials: 

●​ 3D Models: Export them in GLB format. Optimise polygon count for mobile rendering (for an AR 

application is a good practice to use less than 30.000 polygons). 

●​ Images: JPG or PNG files to be used as information panels or decorative elements. 

●​ Audio files: most common formats, for narration. 

●​ Video files: most common formats, short clips: keep file sizes reasonable for streaming, considering 

that the wifi is not guaranteed, it is a good practice to upload video in a 720p resolution (1280x720). 
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3.2 LOG IN TO THE WEB COMPONENT 
 

STEP 2 
Authenticate and Access the Dashboard 
Use your institutional credentials. 

 

1.​ Open your browser and navigate to the 3D XR Studio web component URL. 
2.​ Click Log In and authenticate using the EGI Single Sign-On (SSO) mechanism 
3.​ Once logged in, you will land on the main Dashboard, where all your environments are listed. 

 

 

Figure 1 EGI Single Sign-On (SSO) 

 

3.3 CREATE A NEW ENVIRONMENT​
 

STEP 3 
Set Up Your XR Experience Environment​
Define the basic parameters of your experience. 

 

1.​ From the Dashboard, click Create New Environment. 
2.​ Enter a descriptive name for your environment (e.g., "Ancient City Walls AR Tour"). 
3.​ Specify Longitude and Latitude of the geographical area visible on the world map. 
4.​ Fill the eight input field boxes defining the borders of the area within which the XR experience will 

take place. 
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5.​ Click Save Changes to confirm. A blue shape will highlight the borders of the area available for the 
next steps.​
 

 

Figure 2 Input screen for editing environments 

3.4 IMPORT AND POSITION 3D MODELS 
 

STEP 4 
Add 3D Models to Your Scene​
Place and orient models within the virtual environment. 

 

1.​ Add 3D Objects in the library. 
2.​ Insert them in the scene. 
3.​ The models will appear in the 3D scene. 

 

Once a model is in the scene, position it precisely: 

●​ Set Coordinates: Enter latitude, longitude, and altitude to position the model geographically. 
●​ Set Orientation: Adjust the rotation (x, y and z axis) so that the model aligns correctly with its 

physical counterpart. 
●​ Set Scale: Resize the model to reflect real-world dimensions or the desired visual effect. 
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Figure 3 Input screen for positioning 3D models 

 

💡 Tip: Iterative Fine-Tuning 
Do not worry about achieving perfect placement at this stage. You will have the opportunity to fine-tune all 
model parameters on-site using the mobile component (Step 7). 

3.5 CREATE THE GUIDED TOUR ROUTE 

STEP 5 
Define Path Points and Points of Interest​
Structure the narrative journey for your visitors. 

 

PATH POINTS 

1.​ Click on the map to place Path Points. These define the suggested walking route for visitors. 
2.​ Add, delete, or move points by clicking on them and using the edit controls.​

 

POINTS OF INTEREST 

1.​ Identify locations where you want visitors to stop and engage. 
2.​ Click on the map to place Points of Interest (POIs). 
3.​ For each Point of Interest, you can associate the following content:​

 
●​ Title and descriptive text (displayed as an information panel) 
●​ Audio narration: plays automatically or on tap 
●​ Images: displayed in a gallery 
●​ Video clips  
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Figure 4 Overview of route stops 

 

3.6 SET UP PHYSICAL TOTEMS AND STARTING POINTS 
 

STEP 6 
Anchor the AR Experience in the Physical World​
Define where visitors begin their journey. 

 

The 3D XR Studio uses physical totems — printed panels placed at the site — as real-world reference. 
Visitors use these totems to initialise the AR experience. 

1.​ You can edit the correct placement for each totem in the map. 
2.​ For each physical totem, put the correct QR code on it. 

 

💡 How Visitors Use the Totem 
When a visitor reaches a totem, they scan the QR code, download the app (if not already installed), and 

hold their phone next to the totem. The app uses the totem as a spatial anchor to calibrate the AR scene — 

no internet connection is needed once the initial download is complete. 
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3.7 FINETUNE WITH THE MOBILE COMPONENT 
 

STEP 7 
On-Site Refinement Using AR​
Use the curator view of the mobile component to perfect model placement. 

 

The mobile component has a dedicated Curator Mode that allows you to adjust 3D models in real time, 
directly in the field. 

 
1.​ Install the 3D XR Studio mobile component on your smartphone: 

https://3dstudioxr.eureka3dxr.fedcloud.eu/download 
2.​ Log in with your curator credentials. 
3.​ At each totem location in the real world, initiate the AR scene by scanning the QR code. 
4.​ In Curator Mode, you can: 

 
●​ Select any 3D model and adjust its position, scale, and rotation in real time 
●​ Add visual occlusions to make models appear correctly behind real-world elements 
●​ Add, move, or delete Path Points along the tour 
●​ Preview what the visitor experience will look like from a visitor perspective​

 
5.​ Save all changes: they are synced back to the web application automatically. 

 

💡 Key Reminder 
It is highly recommended to export 3D models in GLB format for best compatibility. 

Optimise model file sizes before uploading to ensure smooth AR performance on mobile devices. 

Test your experience on various smartphones. 

 

3.8 REVIEW 

STEP 8 
Final Checks and Go Live​
Validate your experience and make it available to visitors. 

 

Finally run through this checklist: 

​ All 3D models are correctly positioned and scaled 

​ All Points of Interest have titles, descriptions, and associated media 

​ The tour route flows logically and whenever possible avoid areas with heavy traffic 

​ The totem are placed correctly with their attached QR codes 

​ You have tested the full visitor experience on a mobile device 
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4. THE VISITOR EXPERIENCE 
 

Once the experience is published and the totems are in place, visitors can engage with the AR tour as 
follows: 

Step 1 – Find the Totem The visitor locates a physical totem at the site, following on-site 

signage. 

Step 2 – Download The visitors follow the instructions on the totem in order to download 

the 3D XR Studio mobile component. 

Step 3 – Calibrate After opening the app, the visitors read the instructions inside the 

app. 

Step 4 – Explore The AR experience starts: 3D models appear overlaid on the real 

world, a suggested path is displayed, and audio/text/video media is 

accessible at each POI. 

Step 5 – Navigate The visitor follows the path, discovering each point of interest. The 

experience now works fully offline. 

 
Figure 5 Visitor view on an AR experience 
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5. HELP AND MORE INFORMATION 
Should you encounter any issues or have any questions, please do not hesitate to contact Swing:It via email 
(info@softwareengineering.it). Further information, as well as the latest contact details, are available on the 
official website at swing-it.net. 
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INTRODUCTION 
This step-by-step guideline introduces Avatar Builder, a framework designed to help users create and 

animate 3D avatars for virtual experiences and for multiple visualisation platforms.  

No prior experience in 3D modelling or animation is required. The guide focuses on practical actions and 

clear instructions, allowing curators, educators, and content creators to concentrate on storytelling and 

interpretation rather than technical complexity. 

By following this guide, you will be able to: 

●​ Create a digital human character 

●​ Animate the character using pre-made motions 

●​ Reuse the same avatar across multiple virtual platforms 

 
Figure 1 The framework 
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THIS GUIDE IS INTENDED FOR 
●​ Cultural Heritage Professionals 

●​ Creative and XR professionals 

●​ Or anyone else interested in creating digital characters for virtual experiences 

●​ No programming skills or technical background are required. 

 

TOOLS AND SOFTWARE USED IN THIS GUIDE  
●​ MakeHuman: for creating the avatar’s body, face, and clothing (To install on your computer) 

●​ Mixamo: a web-based service to add animations to your avatar 

●​ Blender: for refining and preparing the avatar for export for visualisation (To install on your 

computer) 

●​ Unity Hub is necessary to streamline the management of multiple Unity Editor versions, projects, 

licenses, and module installations (like Android/iOS support) in one centralised location. While not 

strictly required to run a single version of the editor, it is the official, recommended tool for 

managing installations, projects, and licensing, providing a "gateway" to the Unity ecosystem 

For our Demo, we are using Unity version 2022.3.7f1 

Note: Use the latest stable versions of MakeHuman and Blender. Mixamo works directly in your 

browser, no installation is needed. 

BEFORE YOU START, YOU WILL NEED 
1.​ A computer 

●​ Windows, macOS, or Linux 

●​ Internet access 

Note: A computer with a good graphics card will make Blender run faster, but it’s not strictly 

required for simple avatars. 

2.​ Installation of the software tools 

●​ Install MakeHuman. 

○​ Go to Releases and follow the instructions provided here. 

●​ Install Blender on your computer.  

●​ Mixamo is a web-based tool and does not need installing. ​
 

3.​ Optional materials 

●​ Reference images, sketches, or descriptions of your character 

●​ Headphones or speakers if you want to preview animations with sound 

 

PREPARATION OF YOUR MATERIALS AND WORKSPACE 
●​ Organise folders for each project: 

○​ Raw character files 
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○​ Refined Blender files 

○​ Animated files from Mixamo 

○​ Exported character, FBX folder and GLB folder 

OVERVIEW OF THE WORKFLOW 
​
Creating an animated avatar involves four main steps, each supported by free and accessible tools. Users 

will create the character with MakeHuman, refine its appearance with Blender, add movement in Mixamo 

and finally export it for VR, AR, or web-based platforms. 

 
Figure 2 Overview of the workflow 

 

STEP-BY-STEP GUIDELINES 

STEP 1: AVATAR DESIGN 
 

WHAT IS MAKEHUMAN? 
MakeHuman is a free and open-source 3D computer graphics software used to create realistic virtual 

human characters for use in other projects like video games or animations. It uses a graphical user interface 

with sliders to control macro-level attributes like gender, age, height, and weight, and detail-level features 

for facial and body parts. Users can then export their creations in various formats to other 3D programs like 

Blender or Mixamo. 

The software is developed by a community and supports sharing resources like clothing, poses, and rigs.  
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Figure 3 MakeHuman interface 

 

Using Your Mouse in 3D 

The mouse plays an extremely important role in 3D. With the mouse users can move pieces on the model, 

zoom in/out, move the model, rotate, pan, etc. 

The following diagram demonstrates the way to navigate with the mouse. 

 

HOW TO CREATE AN AVATAR IN MAKEHUMAN? 
 

1.​ Launch MakeHuman ​
Open the MakeHuman software. The workspace will display a default human model.​
 

2.​ Set Base Parameters ​
Go to the Modelling tab.​
In the Modelling tab, adjust the avatar’s basic characteristics:  

a.​ Gender: Male or Female 

b.​ Age: Child, Teen, Adult, or Elder 

c.​ Height and Weight: Modify overall body proportions 
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3.​ Customise Body Features​
Refine body details in the Body section by adjusting: 

a.​ Muscle tone 

b.​ Chest, arms, and legs size 

c.​ Torso and hips proportions 

d.​ Fingers, hands, and feet if needed 

 

4.​ Adjust Facial Features​
In the Face tab, modify facial structure, including: 

a.​ Eyes (shape, size, spacing) 

b.​ Nose (length, width, angle) 

c.​ Mouth and lips (shape, thickness) 

d.​ Ears (size, position) 

e.​ Jaw and cheeks 
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Figure 4 Customising the body and the face 

Customising the body and face in MakeHuman is a key step in creating a realistic and personalised avatar. 

The software provides intuitive sliders that allow you to precisely adjust body proportions such as height, 

weight, muscle definition, chest, arms, legs, torso, and hips. At the same time, detailed facial customisation 

options enable fine control over features including the eyes, nose, mouth, ears, jaw, and cheeks. These tools 

make it possible to shape both the overall physique and the facial identity of the avatar. 

 

5.​ Add Clothing and Accessories 

Clothes and hairstyles can be added to the avatar through the Clothes and Hair sections, where available 
assets can be applied directly to the model. For more variety and customisation, you can access the 
Community tab, which provides a large collection of clothing and hair models created by the MakeHuman 
community. Within this tab, filtering options and keyword search tools allow you to quickly find specific 
types of clothing or hairstyles, such as jackets, shoes, dresses, or particular hair styles. Once selected and 
downloaded, these assets can be easily applied to the avatar. 
 
In the Clothes or Geometries tab: 

a.​ Select clothing items such as shirts, pants, and shoes 

b.​ Adjust size and fit to match the body shape 

 

 Grant Agreement n. 101174054​ ​ 8 

 



 

 

 

 

 

 

 

Figure 5 Clothing the avatar 

 
6.​ Select Skin and Hair 

In the Appearance or Materials section: 

a.​ Choose skin tone and complexion 

b.​ Select hair style and color 

c.​ Set eye color and add eyelashes if desired 

 

 

Figure 6 Adding hair and customising the skin 

 

7.​ Pose and Expression (Optional)​
Use the Pose/Animate tab to: 

a.​ Change the avatar’s pose 

b.​ Add facial expressions if required 
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The Pose and Expression (Optional) tab in MakeHuman allows us to define how the avatar appears in a 
static or dynamic state. If you want to create a static avatar with a specific body pose and facial 
expression, this tab provides predefined poses and expression controls that can be applied easily. By 
selecting an appropriate pose, you can adjust the posture of the avatar to match the intended 
presentation, while facial expression options help convey emotions or character personality. This is 
especially useful when the avatar is intended for visualisation, presentation, or reference purposes 
rather than animation. 

 
Figure 7 Putting the avatar in a T posture 

If the avatar is intended for further animation in Mixamo or other animation software, it is 

recommended to assign a T-pose to the model (Figure 7). A T-pose places the arms extended 

horizontally and the body in a neutral position, which helps facilitate the rigging process by allowing the 

software to correctly detect joints and body proportions. Using a T-pose ensures better compatibility 

with automatic rigging systems, reduces animation errors, and results in smoother and more accurate 

animations. 
 

8.​ Preview the Avatar 

Rotate and zoom in the 3D view to check the avatar from different angles. Make any necessary final 

adjustments. 

9.​ Save and Export 

a.​ Save the project via File → Save for future editing. 

b.​ Export the avatar for use in other applications via File → Export, choosing the desired 

format (obj, .fbx, .dae). 
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The Export Options in MakeHuman allow the user to save the completed avatar in formats compatible 

with external 3D and animation software. For animation purposes, the most commonly used formats 

are FBX and OBJ. Exporting the model in FBX format is recommended when the avatar will be uploaded 

to Mixamo, as this format supports proper geometry and skeletal data required for automatic rigging 

and animation. Alternatively, the OBJ format can also be used, mainly for static models or further 

editing, although it does not include rigging information by default. By exporting the avatar in FBX or 

OBJ format, you can easily import the model into Mixamo, apply animations, and then reuse the 

animated character in games, simulations, or other 3D applications. 

 

Figure 8 Export options 
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STEP 2: AVATAR ANIMATION 
 

WHAT IS MIXAMO? 
Mixamo is a web-based animation platform developed by Adobe that enables you to easily rig and animate 

3D characters without requiring advanced animation skills. It works by automatically by generating a 

skeleton for an uploaded character model and binding it to the mesh through an intuitive auto-rigging 

process. Once rigged, the user can choose from a wide range of predefined animations such as walking, 

running, jumping, or idle movements. These animations can be previewed, adjusted, and applied directly to 

the avatar. This process enables quick and efficient animation creation, making the avatar suitable for use in 

games, virtual reality environments, simulations, or other interactive applications. 

Mixamo is a free service, requiring only an Adobe account to sign in. 

PROCESS OF ANIMATING THE AVATAR IN MIXAMO 

This step-by-step process allows users to quickly transform a static 3D character into a fully animated model 

using Mixamo. 

 

1.​ Access Mixamo 

Open a web browser and go to the Mixamo website. Sign in using an Adobe account.​
 

2.​ Upload the Character 

Click on the Upload Character button and select your exported FBX or OBJ file. Mixamo will load the model 

into the interface.​
 

3.​ Set Rigging Markers 

Once the model is uploaded, Mixamo will ask you to place markers on key body parts, such as the chin, 

wrists, elbows, knees, and groin. These markers help Mixamo understand the character’s anatomy. After 

placing the markers, click Next. Mixamo will automatically generate a skeleton and rig the character. This 

process usually takes a few moments. 
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Figure 9 Upload and rig the avatar in Mixamo 

4.​ Choose an Animation 

After rigging is complete, browse the animation library available in Mixamo. Select an animation such as 

walking, running, jumping, or idle movements. The animation will be applied to the character and 

previewed in real time. 

 
Figure 10 Choosing and adjusting an animation 

5.​ Adjust Animation Settings 

Use the available controls to modify the animation parameters, such as speed, arm spacing, or movement 

intensity, to better suit your needs. 

 

6.​ Download the Animated Character 

Once the animation has been finalised, the user downloads the animated character from Mixamo by 

clicking the Download button.  
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Figure 11 Downloading the animated avatar 

 

7.​ Preparation and Conversion for Final Platform Use 

The downloaded animated character is then prepared for its final use depending on the target platform: 

The FBX format with skin is the most appropriate option, especially for virtual reality (VR) applications, as 

it includes both the character mesh and the animation data in a format that is fully compatible with game 

engines such as Unity. This ensures that the animated avatar can be directly imported and used in 

immersive VR environments without additional rigging or adjustments. 

 

For web visualisation, the FBX file must be converted into a GLB (glTF binary) format, which is more 

efficient and widely supported by web-based 3D viewers.  

This conversion is typically done by importing the FBX file into Blender, where materials, scale, and 

animations can be checked before exporting the model as a GLB file. This process ensures optimal 

performance and compatibility for displaying the animated avatar on the web. 
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STEP 3: AVATAR FORMAT CONVERSION IN BLENDER 
Blender is a free, open-source 3D creation software used for modeling, texturing, animation, and file format 

conversion. It is commonly used as an intermediate tool to prepare and optimise 3D assets for different 

platforms.  

To convert an animated character from Mixamo into a web-friendly format, the user can import the FBX file 

into Blender by selecting File → Import → FBX (.fbx) and choosing the downloaded Mixamo file. (Figure 12) 

 
Figure 12 importing the FBX into Blender 

Once imported, the character, including its mesh, materials, and animations, can be reviewed and adjusted 

if necessary.  
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Figure 13 The imported FBX in Blender 

Note: To avoid visual distraction, you can hide the skeleton from the right-side panel. 

 

Important: A very common issue when importing FBX files from Mixamo into Blender and is usually related 

to how materials and textures are interpreted. 

When the model looks metallic or shiny, Blender is often assigning incorrect values to the Principled BSDF 

shader.  
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Figure 14 Retrieving the correct colors 

To retrieve the correct colors, follow these steps: 

1.​ Check the Material Shader 

a.​ Select the character mesh. 

b.​ Go to the Material Properties panel. 

c.​ Make sure the material uses a Principled BSDF shader.​
 

2.​ Reconnect the Texture Properly 

a.​ Open the Shader Editor. 

b.​ If the texture is not connected correctly, add an Image Texture node. 

c.​ Load the character’s diffuse/albedo texture and connect it to the Base Color input of the 

Principled BSDF shader.​
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3.​ Adjust Metallic and Roughness Values 

a.​ Set Metallic to 0.0 (this usually fixes the metallic look). 

b.​ Increase Roughness to around 0.5–0.7 for a more natural skin or fabric appearance. 

4.​ Check Viewport Shading Mode  

a.​ Switch to Material Preview or Rendered mode to see accurate colors. 

b.​ In Solid mode, colors may appear incorrect or flat. 

 

5.​ Verify Texture Color Space 

a.​ Select the Image Texture node. 

b.​ Set Color Space to sRGB for color (diffuse) textures. 

Note that when you export your model from MakeHuman in FBX, a folder containing the textures 

will be created. This is in case you need to reload your texture in Blender. 

 

6.​ Apply or Reassign Materials if Needed 

a.​ If multiple materials are present, ensure each mesh part has the correct material assigned. 

After these adjustments, the avatar’s colors should appear natural again. This step is especially important 

before exporting the model to GLB for web visualisation, as correct materials ensure proper rendering 

across platforms. 
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Figure 15 The 3D model after shader adjustment 

 

STEP 4: FACIAL ANIMATION (OPTIONAL) IN BLENDER 

Instead of relying on external add-ons, basic facial animation can be achieved directly within Blender using 

shape keys. Shape keys are predefined facial deformations included in the MakeHuman character, allowing 

simple control over expressions such as mouth opening, smiling, or blinking. This method works consistently 

across Blender versions and does not require any additional installation. 

After importing the animated character (with body animation from Mixamo), users can enhance realism by 

adding a few key facial movements. For example, blinking can be created by animating eyelid shape keys at 

regular intervals, and simple mouth movements can be added by keyframing different mouth shapes over 

time. Although this approach does not provide precise lip synchronisation, it is sufficient to give the 

character a more natural and expressive appearance. 

This simplified method ensures that the workflow remains easy to follow, robust, and suitable for 

non-technical users. It also keeps the pipeline fully compatible with modern Blender versions while still 

allowing users to experiment with basic facial animation techniques. 

Once both body animation (from Mixamo) and basic facial animation (using shape keys) are completed in 

Blender, the character can be exported for use in different visualisation environments. 

If the animation includes audio (for example, speech or narration), the sound file should be placed in the 

same folder as the exported 3D file. This ensures proper organisation and makes it easier to link the audio 

with the animation in the target environment. 

This method allows simple facial expressions such as blinking and basic mouth movement to enhance the 

animated character. 
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Quick Steps: Adding Basic Facial Animation in Blender 

1.​ Select the character mesh (face)​
 In the 3D View, click on the character’s head or body mesh.​
 

2.​ Open Shape Keys​
 Go to Object Data Properties (green triangle icon) → Shape Keys. 

 

3.​ Create a blink animation 

a.​ Locate eyelid shape keys (e.g. Blink, EyeClose) 

b.​ Set Value = 0 at frame 1 → Right-click → Insert Keyframe 

c.​ Move to frame 10 → Set Value = 1 → Insert Keyframe 

d.​ Move to frame 20 → Set Value = 0 → Insert Keyframe 

e.​ Repeat later in the timeline for natural blinking 
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Figure 16 Modify the geometry points 

To modify the geometry points and shape the facial expression, switch to Edit Mode. In this example, we 

are creating a blinking animation for the left eye. (Figure 16) 

 

4.​ Create simple mouth movement 

Mouth movements (such as opening the mouth) are created using the same method as blinking eyes, by 

modifying the relevant shape keys in Edit Mode and keyframing their values. 

a.​ Select a mouth shape key (e.g. MouthOpen, A, O) 

b.​ At different frames, change the Value (0 → 1 → 0) 

c.​ Insert keyframes to simulate speaking 
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Figure 17 Creating Shape key for “Mouth open” 

5.​ Animating Shape Keys for Facial Animation 

After creating the required shape keys, animate their values by inserting keyframes at different frames to 

produce the desired facial animation. 

 

Figure 18 keyframes inserted at different time for the different shape keys 
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Figure 19 The generated facial expression at different frames 

6.​ Adding the audio file 

The audio file can be loaded into the timeline, allowing the keyframes to be adjusted accordingly to 

simulate the character speaking in sync with the audio. 

 

Figure 20 Adding an audio file 
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7.​ Play the animation​
Press Spacebar to preview the result and adjust timing if needed. 

This final step completes the pipeline, allowing the animated character to be reused across web and 

immersive platforms. 

Further Resources for facial animation: 

●​ Shape Keys For Beginners 

●​ Facial Shapekeys For Beginners 

After verification, the model can be exported as a GLB (glTF binary) file: File → Export → glTF 2.0 (.glb).  

This format is optimised for efficient loading and rendering, making it ideal for web visualisation and 

real-time applications while preserving animations and textures. 

 
Figure 21 Export to GLB format 
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STEP 5: VISUALISATION OF THE ANIMATED AVATAR IN THE MIRALAB 3D ANIMATION VIEWER 

WEB-BASED VISUALISATION 

MIRALab 3D Animation Viewer is a web-based 3D model viewer with advanced features including audio 

synchronisation, 360° panoramic backgrounds, and multi-scene support. The viewer is hosted by 

Eureka3D-XR github. 

a.​ Upload your 3D files to the EGI DataHub (https://github.com/EUreka3D-XR), A SHARE_ID 

will be automatically created for the file.  

b.​ In your Browser type the following URL by adding the SHARE_ID at the end: 

http://3dwebviewer.eureka3dxr.fedcloud.eu:8141/{SHARE_ID} 

The viewer will: 

a.​ Fetch the file from EGI DataHub 

b.​ Auto-detect the file type 

c.​ Load the appropriate viewer 

d.​ Display the content 

Further information about the viewer can be found here: https://github.com/EUreka3D-XR/​
WebAnimationViewer 

VR/MR VISUALISATION 

To create a VR/MR experience, a ready-to-use Unity template is provided. (put link to data Hub) 

This template already includes all the necessary technical setup (VR camera, scene, and configuration). 

The Unity template is designed to hide technical complexity. Users only need to import their avatar and 

launch the application.  

1.​ Open the Unity template 
a.​ Download and open the provided Unity project 

b.​ All VR settings are already configured 

2.​  Import your avatar 
a.​ Export your character as FBX from Blender 

b.​ Drag and drop the file into the Unity project 

3.​ Replace the example character 
a.​ Delete or hide the placeholder character 

b.​ Drag your avatar into the scene 

4.​ Connect your headset 
a.​ Connect your Meta Quest 3 

b.​ Make sure it is recognised by Unity 

5.​  Build and run 
a.​ Click “Build & Run” 

b.​ The application is automatically installed on the headset  
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Important: for users who are not familiar with tools such as Unity, a complete step-by-step user guide is 

available here. 

HELP AND MORE INFORMATION 
If you require any additional help or have questions regarding the process, please feel free to contact us for 

support. Further assistance can be provided upon request. Additionally, a video demonstrating the same 

workflow described in this manual is available at the following URL, where you can view the complete 

process step by step for better understanding. 

 

●​ Video showing the same workflow: https://www.youtube.com/watch?v=C41Hs9EUxYY 

●​ Further information about the viewer can be found here: 

https://github.com/EUreka3D-XR/WebAnimationViewer 

 
 

Contact MIRALab team: 

●​ Nedjma Cadi (cadi@miralab.ch) 

●​ Dr Thiago Freitas (thiago.freitas@miralab.ch) 

●​ Prof. Nadia Magnenat-Thalmann (thalmann@miralab.ch) 
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